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Limited Lifetime Warranty
Alicat Scientific, Inc. warrants to the original purchaser (hereinafter referred to as “Buyer”) that instruments 
manufactured by Alicat Scientific (hereinafter referred to as “Product”) shall be free from defects in 
materials and workmanship for the life of the Products.
Under this warranty, the Product will be repaired or replaced at manufacturer’s option, without charge 
for parts or labor when the Product is carried or shipped prepaid to the factory together with proof of 
purchase.
The foregoing shall constitute the exclusive and sole remedy in lieu of other remedies of the Buyer for any 
breach by Alicat Scientific of this warranty to the maximum extent permitted by law.
This warranty does not apply to any Product which has not been installed or used in accordance with the 
Product operation and installation specifications provided to Buyer verbally or in writing by Alicat Scientific 
for the proper and normal use of the Product.
Buyer agrees hereunder that Alicat reserves the right to void any warranty, written or implied, if upon 
Alicat’s examination of Product shall disclose to Alicat’s satisfaction that the Product failure was due 
solely, or in part, to accident, misuse, neglect, abuse, alteration, improper installation, unauthorized repair 
or improper testing by Buyer or agent of Buyer.
Alicat Scientific shall not be liable under any circumstances for indirect, special, consequential, or 
incidental damages in connection with, or arising out of, the sale, performance, or use of the Products 
covered by this warranty.
Alicat Scientific does not recommend, warrant or assume responsibility for the use of the Products in life 
support applications or systems.
Alicat’s warranties as herein above set forth shall not be enlarged, diminished or affected by, and no 
obligation or liability shall arise or grow out of Alicat’s rendering of technical advice in connection with 
Buyer’s order of the Products furnished hereunder.
If Product becomes obsolete, Alicat Scientific, at its own discretion, reserves the right to repair the Product 
with available replacement parts or upgrade the Product to a current , commercially available version of 
the original Product. Should upgrading the Product be deemed necessary by Alicat, Buyer hereby agrees 
to pay an upgrade fee equal to seventy percent of the retail value of the replacement Product. Alicat 
Scientific hereunder makes no claim that replacement Products will look, function or operate in the same 
or similar manner as the original product.
When a Product is returned to Alicat Scientific for recalibration this service is considered normal 
preventative maintenance. Recalibration of Product shall not be treated as a warranty service unless 
recalibration of Product is required as the result of repairs to Product pursuant to this Warranty. Failure 
to recalibrate Product on a yearly basis will remove any and all obligations regarding repair or 
replacement of Product as outlined by this Warranty to Buyer from Alicat Scientific.
This Warranty is in lieu of all other relevant warranties, expressed or implied, including the implied 
warranty of merchantability and the implied warranty of fitness for a particular purpose, and any warranty 
against infringement of any patent.
Continued use or possession of Products after expiration of the applicable warranty period stated above 
shall be conclusive evidence that the warranty is fulfilled to the full satisfaction of Buyer. 
Alicat makes no warranty as to experimental, non-standard or developmental Products.
Accessories purchased from Alicat are not covered by this warranty.

Notice: Alicat Scientific, Inc. reserves the right to make any changes and improvements to the products 
described in this manual at any time and without notice. This manual is copyrighted. This document 
may not, in whole or in part, be copied, reproduced, translated, or converted to any electronic medium 
or machine readable form, for commercial purposes, without prior written consent from the copyright 
holder.
Note: Although we provide assistance on Alicat Scientific products both personally and through our 
literature, it is the complete responsibility of the user to determine the suitability of any product to their 
application.

Conformity / Supplemental Information:
The product complies with the requirements of the Low Voltage Directive 73/23/EEC and the EMC 
Directive 89/336/EEC (including 93/68/EEC) and carries the CE Marking accordingly. Contact the 
manufacturer for more information.
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Thank you for purchasing a P Series Pressure Gauge or PC Series Vacuum and 
Pressure Controller. Please take the time to find and read the information for your 
specific device. This manual covers the following Alicat Scientific instruments:

	 P Series Digital Pressure Gauge

	 PC Series Vacuum and Pressure Controllers

	 PC3 Series Vacuum and Pressure Controllers

	 PCR Series High Flow Vacuum and Pressure Controllers 

	 PCR3 Series Vacuum and Pressure Controllers

	 PCD  and PCRD Series Dual Valve Pressure Controllers

	 Alicat Portable Pressure Gauges

	PS, PCS, PCRS, PCDS and PCRDS Series — instruments for use with 
aggressive gases (see page 53).

PC-EXTSEN Series Pressure Controllers — instruments for use with an 
end-user supplied external sensor. (see pages 78-80)

This includes P, PC and PCR Series devices labeled as approved for CSA Class 1 
Div 2 and ATEX Class 1 Zone 2 hazardous environments. See pages 80 and 81 for 
Special Conditions regarding the use of CSA/ATEX labeled devices.

The installation (plumbing, mounting and power/signal connection instructions are 
applicable to all P, PC (includes PC3), PCR (includes PCR3) and PCD series devices. 

Unless specifically noted, all instructions for PC Series Controllers are 
applicable to PC3, PCR, PCR3, PCD and PCRD controllers as well.

Note: Alicat Portable Pressure Gauges operate in accordance with the P Series 
Pressure Gauge instructions found in this manual. Please see page 63 for 
information regarding battery replacement.

Many Alicat instruments are built for specific applications. Two 
instruments with the same flow range and part number may look and 
act quite differently depending upon the application the instrument was 
built for. Care should be taken when moving an instrument from one 
application to another.
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GETTING STARTED

8 Pin Mini-DIN

Display Screen
Inlet Connection Port

Outlet Connection Port 
shown with Plug

Power Jack

P Series Pressure Gauge

Control Valve

Inlet Connection Port

Flow Direction Arrow

Outlet Connection Port

PRESS
PSIA

PC Series Pressure Gauge Shown with Standard Upstream Valve

Inlet Connection Port

Outlet Connection Port

PRESS

PSIA

PCR Series Pressure Gauge Shown with Downstream Valve 
 for Back Pressure Control (page 29)
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MOUNTING
All P Series Gauges and PC Series Controllers have mounting holes for 
convenient mounting to flat panels. These gauges are position insensitive and 
can be mounted in any orientation. The sizes and dimensions for the mounting 
holes are shown on pages 47 to 52.

P Series Pressure Gauges may be connected into your system with the flow 
going in either direction for ease of viewing the display. These units are shipped 
with a plug for dead end applications. This plug should be removed for flow 
through applications.

PC Series Vacuum and Pressure Controllers are normally intended to control the 
process pressure downstream of the controller. In order for this to occur the 
controller should be mounted so the flow goes from left to right as you look at 
the front of the unit. This puts the measuring portion of the device between the 
valve and the leakage point where you are attempting to control the pressure 
application. Back-pressure controllers reverse this configuration (see page 29).

PLUMBING
Your instrument is shipped with plastic plugs fitted in the port openings. 
To lessen the chance of contaminating the flow stream do not remove 
these plugs until you are ready to install the device.

Make sure that flow is in the direction indicated by the flow arrow.
Standard P Series Gauges and PC Series Controllers have female inlet and outlet 
port connections. Welded VCR and other specialty fittings may have male ports.
The inlet and outlet port sizes (process connections) for different flow ranges 
are shown on pages 45-52.
Instruments with M5 (10-32) ports have O-ring face seals and require no 
sealant or tape. Do not use tape with welded or o-ring fittings.
For non M5 (10-32) ports use thread sealing Teflon® tape to prevent leakage 
around the port threads. 
Do not wrap the first two threads. This will minimize the possibility of getting 
tape into the flow stream and flow body. 

Do not use pipe dopes or sealants on the process connections as these 
compounds can cause permanent damage to the controller should they get 
into the flow stream.

When changing fittings, carefully clean any tape or debris from the port threads.

For additional notes on PCD (dual valve controller) plumbing see page 33.

For gas applications, it is recommended that a 40 micron filter be installed 
upstream of P and PCR Series instruments and a 20 micron filter be installed 
upstream of PC and PCD Series instruments. 

For liquid applications, see “Using P and PC Series Instruments with Fluids”, page 8.
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USING P AND PC SERIES INSTRUMENTS WITH FLUIDS

All of these devices may by used with chemically compatible liquids providing a 
couple of things are taken into account:

1.	 Water is about 50 times more viscous than air. This is important when 
sizing a pressure controller.  The PC Series which can be used to flow 
up to 20 SLPM of gas, will be limited to roughly 0.5 LPM of water-like 
fluid. The PCR will be limited to roughly 30 LPM of water-like fluid.

2.	 The factory PID tune is established using air flow. It may be necessary 
to adjust the PID tuning parameters if you will be using a controller 
with liquids.

SPECIAL CONFIGURATIONS

P, PC, and PCR Series pressure devices are occasionally ordered with special 
configurations which are covered here:

1.	 External Sense Port: Occasionally it is necessary or desirable to sense 
the pressure at some point other than at the location of the pressure 
device. All P, PC, or PCR Series pressure devices can be ordered with 
an additional NPT port which is connected directly with the pressure 
sensor of the device. In these devices the flow path through the device 
is NOT connected to the pressure sensor. See  “PC3 Series Pressure 
Controllers” – page 30.

2.	 Differential Pressure: Occasionally it is necessary or desirable to 
monitor or control a differential pressure. P, PC, and PCR Series 
pressure devices can be ordered as low differential pressure devices 
(usually 1 to 5 PSID). These devices have two ports located on the front 
face of the unit for connection to the points in the system where the 
differential pressure is to be measured. The upstream port is for the 
higher pressure and the downstream port is for the lower pressure. In 
these devices the flow path through the device is NOT connected to 
either leg of the differential pressure sensor. See “Differential Pressure 
Gauges and Differential Pressure Controllers” – page 32.

PC-EXTSEN units connect a Pressure Controller (with no internal pressure 
sensor) to an end-user supplied external pressure sensor. Designed mainly 
for the vacuum coating industry, the PC-EXTSEN marries the sensing ability of 
an existing capacitance manometer or ion gauge with a 16 Series electronics 
package and internal PID algorithm. This enables fast and precise control of 
extreme vacuum conditions in the coating chamber. See pages 78-80.

CAUTION!  Exceeding the maximum specified line pressure may 
cause permanent damage to the solid-state differential pressure 
transducer.
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POWER AND SIGNAL CONNECTIONS
Power can be supplied to your gauge/controller through either the power jack or 
the 8 pin Mini-DIN connector. 
An AC to DC adapter which converts line AC power to DC voltage and current as 
specified below is required to use the power jack. 
A 2.1mm, positive center, 7-30 Vdc AC/DC adapter rated for at least 100 mA is 
required to use the adapter jack in a P Series meter.
A 2.1mm, positive center, 12-30 Vdc AC/DC adapter rated for at least 250 mA is 
required to use the adapter jack in a PC Series controller. 
A 2.1mm, positive center, 24-30 Vdc AC/DC adapter rated for at least 500 mA is 
required to use the adapter jack in a PCR Series controller.
NOTE: 4-20mA analog output requires at least 15 Vdc.

CAUTION! Do not connect power to pins 1 through 6 as permanent damage can occur!

Standard 8 Pin Mini-DIN Pin-Out

Pin Function Mini-DIN 
cable color

1 Inactive or 4-20mA Primary Output Signal Black

2 Static 5.12 Vdc or Secondary Analog Output (4-20mA, 5Vdc, 10Vdc) 
                         or Basic Alarm Brown

3 RS-232 Input Signal Red
4 Analog Input Signal Orange
5 RS-232 Output Signal Yellow
6 0-5 Vdc (or 0-10 Vdc) Output Signal Green
7 Power In (as described above) Blue
8 Ground (common for power, communications and signals) Purple

Note: The above pin-out is applicable to all gauges and controllers with the Mini‑DIN 
connector. The availability of different output signals depends on the options ordered. 
Underlined Items in the above table are optional configurations that are noted on the 
unit’s calibration sheet. DO NOT use the above pin-out for PC-EXTSEN controllers! See 
pages 78-80 for PC-EXTSEN pin-outs. 



 







It is common to mistake Pin 2 (labeled 5.12 Vdc Output) as the standard 0-5 Vdc 
analog output signal. In fact Pin 2 is normally a constant 5.12 Vdc that reflects the 
system bus voltage and can be used as a source for the set-point signal.

For 6 Pin Locking Connector, DB9, DB15 and PROFIBUS Pin‑outs see pages 69 to 77.

1 2

3 4 5

6 7 8



10

INPUT SIGNALS
Analog Input Signal
Apply analog input to Pin 4 as shown on page 9.
For 6 Pin Locking Connector, DB9, DB15 and PROFIBUS Pin‑outs see pages 68 to 76.
Standard 0-5 Vdc is the standard analog input signal. Apply the 0-5 Vdc input 
signal to pin 4, with common ground on pin 8. 
Optional 0-10 Vdc: If specified at time of order, a 0-10 Vdc input signal can be 
applied to pin 4, with common ground on pin 8.
Optional 4-20 mA: If specified at time of order, a 4-20 mA input signal can be 
applied to pin 4, with common ground on pin 8. 
NOTE: This is a current sinking device. The receiving circuit is essentially a 250 
ohm resistor to ground.  
NOTE: 4-20mA output requires at least 15 Vdc power input.

CAUTION!  Do not connect this device to “loop powered’” 
systems, as this will destroy portions of the circuitry and void 
the warranty. If you must interface with existing loop powered 
systems, always use a signal isolator and a separate power supply.

Gauges: A remote tare can be achieved by momentarily grounding pin 4 to tare. 

 

7 6

5 4 3

2 1

8

5.12 Vdc

50 KOhm 
Potentiometer

0-5 Vdc

Controllers: A simple method for providing set-point to controllers
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RS-232 / RS‑485 Digital Input Signal

To use the RS-232 or RS-485 input signal, connect the RS-232 / RS‑485 Output 
Signal (Pin 5), the RS-232 / RS‑485 Input Signal (Pin 3), and Ground (Pin 8) to 
your computer serial port as shown below. (See page 34 for details on accessing 
RS-232 / RS‑485 input.)













9 8 7 6



9876

15 3 24 1 532 4

Serial Cable End PC Serial Port



 









 











1

8 7 6

5

4

3

2

8 Pin MiniDIN Cable End 8 Pin MiniDIN Connector

9 Pin Serial Connection 8 Pin MiniDIN Connection
Pin Function Function Pin
5 Ground Ground 8
3 Transmit Receive 3
2 Receive Transmit 5

DB9 to Mini-DIN Connection for RS-232 / RS-485 Signals
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OUTPUT SIGNALS

RS-232 / RS-485 Digital Output Signal

To use the RS-232 or RS-485 output signal, it is necessary to connect the RS-232 
/ RS‑485 Output Signal (Pin 5), the RS-232 / RS‑485 Input Signal (Pin 3), and 
Ground (Pin 8) to your computer serial port as shown on page 8. (See page 34 
for details on accessing RS-232 / RS‑485 output.)

Standard Voltage (0-5 Vdc) Output Signal

Gauges/controllers equipped with a 0-5 Vdc (optional 0-10 Vdc) will have this 
output signal available on Pin 6. This output is generally available in addition to 
other optionally ordered outputs. This voltage is usually in the range of 0.010 
Vdc for zero flow and 5.0 Vdc for full-scale flow. The output voltage is linear 
over the entire range. Ground for this signal is common on Pin 8.

Optional 0-10 Vdc Output Signal

If your gauge/controllerwas ordered with a 0-10 Vdc output signal, it will be 
available on Pin 6. (See the Calibration Data Sheet that shipped with your device 
to determine which output signals were ordered.) This voltage is usually in the 
range of 0.010 Vdc for zero flow and 10.0 Vdc for full-scale flow. The output 
voltage is linear over the entire range. Ground for this signal is common on Pin 8.

Optional Current (4-20 mA) Output Signal

If your gauge/controllerwas ordered with a 4-20 mA current output signal, it will 
be available on Pin 1. (See the Calibration Data Sheet that shipped with your 
device to determine which output signals were ordered.) The current signal is 
4 mA at 0 flow and 20 mA at the device’s full scale flow. The output current is 
linear over the entire range. Ground for this signal is common on Pin 8. (Current 
output units require 15-30Vdc power.)

Optional 2nd Analog Output Signal

You may specify an optional 2nd analog output on Pin 2 at time of order. (See 
the Calibration Data Sheet that shipped with your device to determine which 
output signals were ordered.) This output may be a 0-5 Vdc, 0-10 Vdc, or 
4-20 mA analog signal that can represent any measured parameter. With this 
optional output, a meter could output the volume flow rate (0-5 Vdc on pin 6) 
and the line temperature (0-5 Vdc on pin 2). 

If your device is CSA/ATEX approved or equipped with the optional six pin 
industrial connector, please contact Alicat.

CAUTION!  Do not connect this device to “loop powered’” 
systems, as this will destroy portions of the circuitry and void 
the warranty. If you must interface with existing loop powered 
systems, always use a signal isolator and a separate power supply.
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Typical Multiple Device (Addressable) Wiring Configuration

The easiest way to connect multiple devices is with a Multi-Drop Box 
(see page 65).

CAUTION!  Do not connect this device to “loop powered’” 
systems, as this will destroy portions of the circuitry and void 
the warranty. If you must interface with existing loop powered 
systems, always use a signal isolator and a separate power supply.

5
3

2

Purple

Red
Yellow

Purple

Red
Yellow

5 4 3 2 1

9
8 7

6

Unit C

Unit B

Unit A

Female Serial Cable Front

Purple (Ground)

Red
Yellow
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Information for Alicat TFT (Color Display) Instruments
Alicat TFT (color display) instruments have a high contrast back-lit LCD display. 
TFT instruments operate in accordance with Alicat standard operating instructions 
for our monochrome menus and displays with the following differences. 

Multi-Color Display Color Codes:

GREEN: Green labels identify the parameters and/or adjustments 
associated with the button directly above or below the label.

WHITE: The color of each parameter is displayed in white while operating 
under normal conditions.

RED: The color of a parameter is displayed in red when operating 
conditions for that parameter exceed 128% of the device’s specifications.

YELLOW: Yellow is the equivalent of the selection arrow on the 
monochrome display.

LCD Contrast: 
LCD contrast is ranged from 1 to 11 on color displays with 11 being the greatest 
contrast.

Display On/Off: 
Pushing the button under the Alicat name will turn the device display on or off. 
This feature is not available on monochrome displays.

Technical Data for TFT (Color Display) Meters, Gauges and Controllers

The following specifications are applicable to Alicat TFT (color display) meters, 
gauges and controllers only. All other operating specifications are shown in the 
Technical Data page for standard Alicat instruments. All standard device features 
and functions are available and operate in accordance with the Alicat operating 
manual provided with the device. 

Specification Meter  or 
Gauge

Small Valve 
Controller

Large Valve 
Controller

Supply Voltage 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc
Supply Current 80 mA @ 12Vdc

70 mA @ 24Vdc
290 mA @ 12Vdc
200 mA @ 24Vdc

780 mA @ 
24Vdc
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The Main display shows the pressure in 
the units specified at time of order.
By hitting the MENU button at the 
bottom right of the screen you will 
enter the Select Menu display.

DISPLAYS AND MENUS P SERIES GAUGES
(Displays and Menus for PC and PCR Controllers are shown beginning page 21.)

The device screen defaults to Main display as soon as power is applied to the meter.

Select Menu
From Select Menu you can interact 
with your RS-232 / RS-485 settings 
or read manufacturer’s data. 
Push MAIN to return to the Main display.

RS232 
COMM

MFG
DATA

MAIN

MISC

Select Menu

MENU

TARE V 

PRESS
PSIG

PSIG
+13.60

+   .

Main

Note: P Series Pressure Gauges may also be ordered as portable devices as 
described on page 63.
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MAIN 
This mode defaults on power up, with 
flow as the primary displayed parameter. 
The following parameters are displayed in 
the Main mode.
Line Pressure shows the pressure in the 
units specified at time of order.

Tare: Pushing the TARE P button tares 
the pressure gauge and provides it with a 
reference point for zero pressure. 

This is an important step in obtaining 
accurate measurements. It is best to 
zero the pressure gauge each time it is 

powered up. If the pressure reading varies significantly from zero after an initial 
tare, give the unit a minute or so to warm up and re-zero it.

If in doubt about whether the pressure is zero, remove the gauge from the 
line and open both ports to atmosphere before entering the Tare command. 
For liquid pressure devices, all liquid must be drained from the gauge and any 
plumbing between the gauge and the atmosphere.

If the unit reads significantly different than zero when it is exposed to 
atmospheric pressure, it is a good indication that it was given a false tare.

MENU: Pressing MENU switches the screen to the Select Menu display.

MENU

TARE P

PRESS
PSIG

PSIG
+13.60

+   .

Flashing Error Message: An error message (POV = pressure 
overrange) flashes when pressure exceeds the range of the sensor. 
When any item flashes, the pressure measurement is not accurate. 

Reducing the pressure to within specified limits will return the unit to normal 
operation and accuracy. 

If the unit does return to normal operation contact Alicat.

Do Not Attempt To Tare Absolute Pressure (PSIA) Instruments!
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RS232 
COMM

MFG
DATA

MAIN

MISC

SELECT MENU
From Select Menu you can interact with your RS‑232 / RS-485 settings or read 
manufacturer’s data.
Press the button next to the desired operation to bring that function to the screen.

Miscellaneous
Communication Select

Main

Manufacturer Data

An explanation for each screen can be found on the following pages.

MAIN

TARE P

PRESS
PSIG

PSIG
+13.60

+   .

MODEL
INFO

BACK MAIN1

A L I C A T  S C I E N T I F I C

Ph    520-290-6060

Fax  520-290-0109
PRESS

AVG

BACK

LCD

CONTRAST MAIN

ZERO
BAND

FLOW
AVG

BACK MAIN

UNIT ID
A

BAUD
19200

Select Menu
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COMMUNICATION SELECT
Access Communication Select by pressing 
the button above RS232 COMM or RS485 
COMM on the Select Menu display. 
Unit ID – Valid unit identifiers are the 
letters A-Z and @. The identifier allows 
you to assign a unique address to each 
device so that multiple units can be 
connected to a single RS‑232 or RS‑485 
computer port. 
Press UNIT ID. Use the UP and DOWN 
buttons to change the Unit ID. Press SET to 
record the ID. Press Reset to return to the 
previously recorded Unit ID.
Any Unit ID change will take effect when 
Communication Select is exited.
If the symbol @ is selected as the Unit 
ID, the device will enter streaming mode 
when Communication Select is exited. 
See RS-232 Communications (page 37) for 
information about the streaming mode.
Baud – Both this instrument and your 
computer must send/receive data at the 
same baud rate. The default baud rate for 
this device is 19200 baud. 
Press the Select button until the arrow is 
in front of Baud. Use the UP and DOWN 
buttons  to select the baud rate that 
matches your computer. The choices are 
38400, 19200, 9600, or 2400 baud. 
Any baud rate change will not take effect 
until power to the unit is cycled.

UP

BACK RESET A SET

UNIT ID
C

DN

DN

BACK SET

BAUD UP

19200

BACK MAIN

UNIT ID
A

BAUD
19200

C
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MISCELLANEOUS 
Miscellaneous is accessed by pressing the MISC button on the Select Menu display. 
NOTE: All Miscellaneous changes are recorded when you exit Miscellaneous. 
ZERO BAND refers to Display Zero Deadband. Zero deadband is a value below 
which the display jumps to zero. This deadband is often desired to prevent electrical 
noise from showing up on the display as minor flows or pressures that do not exist. 
Display Zero Deadband does not affect the analog or digital signal outputs.

ZERO BAND can be adjusted between 0 and 
3.2% of the sensor’s Full Scale (FS). 
Press ZERO BAND. Then use SELECT to 
choose the decimal with the arrow and the 
UP and DOWN buttons to change the value. 
Press SET to record your value. Press CLEAR 
to return to zero.
Pressure Averaging may be useful to make 
it easier to read and interpret rapidly 
fluctuating pressures and flows. Pressure 
and flow averaging can be adjusted between 
1 (no averaging) and 256 (maximum 
averaging). These are geometric running 
averages where the number between 1 and 
256 can be considered roughly equivalent to 
the response time constant in milliseconds. 
This can be effective at “smoothing” high 
frequency process oscillations such as those 
caused by diaphragm pumps. 
Press PRESS AVG. Then use SELECT to 
choose the decimal with the arrow and the 
UP and DOWN buttons to change the value.
Setting a higher number will equal a 
smoother display. 
Flow Averaging: While FLOW AVG appears 
on the display, this adjustment has no 
application in pressure devices. Changing 
it will have no effect on the operation of a 
pressure device.
LCD CONTRAST: The display contrast can be 
adjusted between 0 and 30, with zero being 
the lightest and 30 being the darkest.  
Use the UP and DOWN buttons to adjust the 
contrast. Press SET when you are satisfied.
Press CANCEL to return to the MISC display.

DOWN

CANCEL RESET SET

UP

11

PRESS
AVG

BACK

LCD

CONTRAST MAIN

ZERO
BAND

FLOW
AVG

DOWN

CANCEL CLEAR SET

UP SELECT

0.0

>
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MANUFACTURER DATA
Manufacturer Data is accessed by 
pressing the MFG DATA button on the 
Select Menu display. 

The initial display shows the name 
and telephone number of the 
manufacturer.

Press MODEL INFO to show important 
information about your flow meter 
including the model number, serial 
number, and date of manufacture. 

Press BACK to return to the MFG DATA 
display.

Push MAIN to return to the Main display.

MODEL
INFO

BACK MAIN

A L I C A T  S C I E N T I F I C

Ph    520-290-6060

Fax  520-290-0109

BACK MAIN

MODEL:  PC-10PSIG-D
SERIAL  NO:  80003
DATE  MFG:    10/7/2012
DATE  CAL:    10/9/2012
CAL  BY:  DL
SW REV:  2V62
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The Main display shows, temperature 
and volume flow. Line pressure will be 
also be displayed if the meter was order 
with this option.
Pressing the button adjacent to a 
parameter will make that parameter 
the primary display unit.
By hitting the MENU button at the 
bottom right of the screen you will 
enter the Select Menu display. 

DISPLAYS AND MENUS PC AND PCR CONTROLLERS
(Displays and Menus for P Gauges are shown beginning page 15.)

The device screen defaults to Main display as soon as power is applied to the controller.

Select Menu
From Select Menu you can interact 
with your RS-232 / RS-485 settings, 
read manufacturer’s data or access 
the control set-up display. 
Push MAIN to return to the Main display.

CONTROL
SETUP

RS232 
COMM

MFG
DATA

MAIN

MISC

Select Menu

MENU

SETPT
0.000  

PRESS
PSIA

PSIA
+13.60

+   .

Main



22

MAIN 
This mode defaults on power up, with flow 
as the primary displayed parameter. 
The following parameters are displayed in 
the Main mode.
Line Pressure shows the pressure in the 
units specified at time of order.
Set Point: The set-point (SETPT)is shown 
in the upper right of the display. 
For information on changing the set-point 

see SETPT SOURCE, page 24.
MENU: Pressing MENU switches the 
screen to the Select Menu display.

MENU

SETPT
0.000  

PRESS
PSIG

PSIG
+13.60

+   .

Flashing Error Message: An error message (POV = pressure 
overrange) flashes when pressure exceeds the range of the sensor. 
When any item flashes, the pressure measurement is not accurate. 

Reducing the pressure to within specified limits will return the unit to normal 
operation and accuracy. 

If the unit does return to normal operation contact Alicat.
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CONTROL
SETUP

RS232 
COMM

MFG
DATA

MAIN

MISC

SELECT MENU
From Select Menu you can change the selected gas, interact with your 
RS‑232 / RS-485 settings, read manufacturer’s data and access the control 
setup screen.
Press the button next to the desired operation to bring that function to the screen.

Miscellaneous
Communication Select

Control Setup

Main

Manufacturer Data

An explanation for each screen can be found on the following pages:
Control Setup: Please see page 24.

Communication Select: Please see page 18.

Miscellaneous: Please see page 19.

Manufacturer Data: Please see page 20.

MAIN

SETPT
0.000  

PRESS
PSIG

PSIG
+13.60

+   .

MODEL
INFO

BACK MAIN

A L I C A T  S C I E N T I F I C

Ph    520-290-6060

Fax  520-290-0109

LOOP
VAR

OFF
AUTO PID MAIN

SETPT
SOURCE

PRESS
AVG

BACK

LCD

CONTRAST MAIN

ZERO
BAND

FLOW
AVG

BACK MAIN

UNIT ID
A

BAUD
19200

SETPT
+0.00  

Select Menu
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CONTROL SETUP 
Control Setup is accessed by pressing the button below Control Setup on the 
Select Menu display. From this screen you can select your set-point source, 
choose a loop variable and adjust the PID terms.

Press BACK to return to the Select Menu 
display. 
Press MAIN to return to the MAIN display
SETPT SOURCE – Pressing the button 
above SETPT SOURCE will allow you to 
select how the set point will be conveyed 
to your controller. 
Use the line-up and line-down buttons 
to move the arrow in front of the desired 
option. Then press SET.
Press CANCEL to return to the previous 
display. 
The controller will ignore any set-point 

except that of the selected set-point source and it will remember which input is 
selected even if the power is disconnected.

RS-232 (or RS-485) refers to a remote 
digital RS-232 / RS-485 set-point applied 
via a serial connection to a computer or 
PLC as described in the installation and 
RS‑232 / RS-485 sections of this manual. 

Front Panel refers to a set-point applied 
directly at the controller. 

Front Panel input must be selected 
prior to changing the set-point at 
the device. 

Analog refers to a remote analog set-
point applied to Pin 4 of the Mini-DIN 
connector as described in the installation 

section of this manual. The standard analog input is 0-5 Vdc. 
To determine what type of analog set-point your controller has, refer to 
the Calibration Data Sheet that was included with your controller. 

If nothing is connected to Pin 4, and the controller is set for analog control, the 
set-point will float. 
NOTE: If your controller has the IPC (Integrated Potentiometer Control) option, 
the IPC dial will operate with the ANALOG set-point source selected.

SETPT refers to the set-point. This parameter may be changed using the display 
only if FRONT PANEL is selected as the Input. Press SETPT. Then use SELECT to 
choose the decimal with the arrow and the UP and DOWN buttons to change 
the value. Press SET to record your value. Press CLEAR to return to zero.

LN-DN

CANCEL SET

LN-UP MODE

 >RS232
   FRONT PANEL
   ANALOG

LOOP
VAR

ON
AUTO PID MAIN

SETPT
SOURCE

SETPT
+0.0
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CAUTION!  Never leave a Controller with a non-zero set‑point if 
no pressure is available to make flow. The controller will apply 
full power to the valve in an attempt to reach the set‑point. 
When there is no flow, this can make the valve very HOT!

CONTROL SETUP (continued)
LOOP VAR—Pressure controllers are 
defaulted to pressure. 
Pressure means that the controller is 
“closing the loop” on the pressure. This 
means that when you give the controller 
a set-point, the controller compares 
that set-point to the measured pressure 
and adjusts the valve to try to make the 
pressure and the set-point match. For the 
pressure, the input signal (e.g. 0-5 Vdc) 
corresponds to the full-scale pressure for 
the device.

LOOP
VAR

OFF
AUTO PID MAIN

SETPT
SOURCE

LN-DN

CANCEL SET

LN-UP MODE

 >  Pressure
   

SETPT
+0.0
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LOOP
VAR

OFF
AUTO PID MAIN

SETPT
SOURCE

CONTROL SETUP (continued)

Tareing (or zeroing) a gauge pressure or 
differential pressure controller provides it 
with a reference point for zero pressure. 

OFF AUTO / ON AUTO—this feature allows 
you to tare the controller.

The controller must be left in the default 
OFF AUTO mode except when actually 
tareing the controller as explained below. 

It is, however, very important to perform 
this adjustment only when you are 
certain that the process ports are open to 
atmosphere and that there is No Flow! 

For liquid pressure devices, all liquid must be drained from the system. 
To correctly tare a gauge pressure or differential pressure controller:

1. Be sure the unit is in the OFF AUTO default setting.
2. Disconnect all plumbing and make sure there is No Flow.
3. Push the button below OFF AUTO once so that the display reads ON AUTO.
4. Enter a Set-Point of ZERO. A zero set-point results in the closing of the valve 
and a known “no flow” condition.
5. Wait at least 30 seconds.
6. Push the button below ON AUTO once so that the display reads OFF AUTO.
7. Reconnect the plumbing.

If the unit reads significantly different than zero, when removed from 
the line and open, it is a good indication that it was given a false zero.

If your pressure controller was ordered with the optional “Tare-P”, you 
may tare it following the instructions for tareing a pressure gauge on 
page 16

Do Not Attempt To Tare Absolute Pressure (PSIA) Instruments!
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PID TUNING

PID Values determine the performance 
and operation of your proportional 
control valve. These terms dictate control 
speed, control stability, overshoot and 
oscillation. All units leave the factory with 
a generic tuning designed to handle most 
applications. If you encounter issues with 
valve stability, oscillation or speed, fine 
tuning these parameters may resolve the 
problem.
Alicat controllers allow you to adjust the 
Proportional, Integral and Differential 
terms of the PID control loop. 
To change the PID loop parameters, push 
the button below PID.
Press LOOP TYPE. Then use the LN-UP and 
LN-DN buttons to select the appropriate 
PID control algorithm. Press SET.
See the following page for descriptions 
of the PID Loop Types (PID Control 
Algorithms).

P refers to the Proportional term of the 
PID loop. 
I refers to the Integral term of the PID loop. 
D refers to the Differential term of the 
PID loop. 
Press P, I or D. Then use SELECT to choose 
the decimal with the arrow and the UP 
and DOWN buttons to change the value. 
Press SET to record your value. Press 
CLEAR to return to zero.

Before changing the P, I or D 
parameter, please record the initial 
value so that it can be returned to 

the factory setting if necessary.
Valve tuning can be complex. If you 
would like assistance, please contact 
Alicat for technical support.

I
00000

BACK
LOOP
TYPE MAIN

P
00100

D
02501

LN-DN

CANCEL SET

LN-UP MODE

 >PID
   PD PID
   PD2I PID

LOOP
VAR

ON
AUTO PID MAIN

SETPT
SOURCE

SETPT
+0.0
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The PID algorithm is an industry standard PID algorithm. It is divided into three segments.
The first compares the process value to the set-point to generate a proportional error. 
The proportional error is multiplied by the ‘P’ gain, with the result added to the output 
drive register. 
The second integrates the proportional error times the ‘I’ gain over time and adds the 
result to the output drive register. 
The third operates on the present process value minus the process value during the 
immediately previous evaluation cycle. This ‘velocity’ term is multiplied by the ‘D’ gain, 
with the result subtracted from the output drive register. 
Increasing the ‘P’ gain will promote the tendency of the system to overshoot, ring, or 
oscillate. Increasing the ‘D’ gain will reduce the tendency of the system to overshoot. ‘I’ 
gain is used to control the rate at which the process value converges upon the set-point.
The PD PID algorithm is the PID algorithm used on most Alicat controllers. It is a 
simplified version of the above described PID method. It is divided into two segments:
The first compares the process value to the set-point to generate a proportional error. 
The proportional error is multiplied by the ‘P’ gain, with the result added to the output 
drive register. 
The second operates on the present process value minus the process value during the 
immediately previous evaluation cycle. This ‘velocity’ term in multiplied by the ‘D’ gain, 
with the result subtracted from the output drive register. 
The above additions to and subtractions from the output drive register are carried over from 
process cycle to process cycle, thus performing the integration function automatically. 
Increasing the ‘P’ gain will promote the tendency of the system to overshoot, ring, or 
oscillate. Increasing the ‘D’ gain will reduce the tendency of the system to overshoot. 
The reduction in the number of variables from three to two, greatly simplifies the tuning process. 
The PD2I PID algorithm is used primarily for high performance pressure and flow control 
applications. It exhibits two basic differences from the PD PID algorithm that most 
controllers utilize.
1. Instead of applying a damping function based upon the rate of change of the process value, it 
applies a damping function based upon the square of the rate of change of the process value.
2. The damping function is applied directly to the proportional error term before that 
term is used in the proportional and integral functions of the algorithm. This provides a 
certain amount of ‘look ahead’ capability in the control loop.
Because of these differences, you will note the following:
1. Increasing ‘P’ gain can be used to damp out overshoot and slow oscillations in 
pressure controllers. You will know that ‘P’ gain is too high, when the controller breaks 
into fast oscillations on step changes in set-point. On flow controllers, too high a ‘P’ gain 
results in slower response times. Too low a ‘P’ gain results in overshoot and/or slow 
oscillation. A good starting value for ‘P’ gain is 200.
2. If the unit was originally shipped with the PD2I algorithm selected, the ‘D’ gain value 
should be left at or near the factory setting because it relates primarily to the system 
phase lags. If you are changing from the default algorithm to the PD2I algorithm, you 
should start with a ‘D’ gain value of 20.
3. The ‘I’ gain is used to control the rate at which the process converges to the set-point, 
after the initial step change. Too low a value for ‘I’ gain shows up as a process value that 
jumps to near the set-point and then takes awhile to converge the rest of the way. Too 
high a value for ‘I’ gain results in oscillation. A good starting value for the ‘I’ gain is 200.
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FLOW

Alicat Precision 
Pressure Controller

Pressure Control Application, Upstream Valve

Back Pressure Control Application, Downstream Valve (DS)
Specify DS in part number adder code

Mechanical 
Pressure 
Regulator

Mechanical 
Pressure 
Regulator

Vent Flow

FLOW

Alicat Precision 
Pressure Controller

Process

Process
Flow Exiting
Bleed Port

Upstream and Downstream Valve Diagram
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PC3 AND PCR3 SERIES PRESSURE CONTROLLERS:

The PC3 and PCR3 Series pressure controller is designed to change the 
flow to allow the control of pressure at some point away from the body of 
the controller. 

This is most helpful when it is necessary to mount pneumatic components 
such as valves, fittings or flow meters that introduce significant pressure 
drop between pressure controller body and the point where pressure 
control is necessary. 

To accomplish this, the PC3 has an external sensing port to which the pressure 
at the location where pressure is to be controlled is piped back to the pressure 
sensor in the controller.

P1

P3

P3 P3 P3

P3

P3P2

Nozzle Under Test

Flow Meter (Pressure Drop)PC3 Series Pressure ControllerPC3 Series Pressure Controller	         Flow Meter (Pressure Drop)

Nozzle Under Test

P1 P2

P3 P3

P3

Typical PC3 Application
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DIFFERENTIAL PRESSURE GAUGES:

The differential pressure gauge is designed to 
measure a pressure ratio between two points in 
the line. There are a variety of applications for 
this device. 

One of the most common is to measure the 
difference in pressure across some sort of 
element that changes resistance to flow over 
time, such as a filter, or one that changes area 
with time as would happen with orifice testing. 

The gauge has two sensing ports which are piped 
to the upstream and downstream sides of the 
pressure drop of interest in the system. 

These two ports run either to two separate 
pressure sensors or for low differential pressures – they may be run to the two 
legs of a single differential pressure sensor. The higher (upstream) pressure is 
applied to the left port and the lower (downstream) pressure is applied to the 
right port.

P1

P2

Differential Pressure Gauge Application
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DIFFERENTIAL PRESSURE CONTROLLERS:

The differential pressure controller is designed to change the flow to allow the 
control of a pressure ratio between two points in the line. There are a variety of 
applications for this device. 

One of the most common is to control the difference in pressure across some 
sort of element that changes resistance to flow over time, such as a filter 
or one that changes area with time as would happen with orifice testing. To 
accomplish differential pressure control, the controller has two sensing ports 
which are piped to the upstream and downstream sides of the pressure drop in 
the system. 

These two ports run either to two separate pressure sensors or for low 
differential pressures – they may be run to the two legs of a single differential 
pressure sensor. The controller itself changes the flow to the two sensing ports 
until the difference between the two pressures matches the set-point.

P2P1

P2P1 P2P1

Differential Pressure Controller Application
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PCD SERIES DUAL VALVE PRESSURE CONTROLLER OPERATION
Alicat Scientific PCD Series Closed Volume Pressure Controllers incorporate a 
digital pressure gauge with dual control valves and circuitry. The integrated PID 
loop measures the pressure, compares it with the set-point, and adjusts either 
the Inlet or Exhaust valve accordingly in excess of two thousand times per second. 
It is most common to have a .050 inch diameter orifice in the inlet valve, and 
a .050 inch diameter exhaust valve. The response time of the system will 
depend on the size of the volume being controlled and the feed pressure. The 
controllers are intended for use with clean, non-corrosive gases only. 
They are designed with a feed port, a process port, and an exhaust port. This 
allows the controllers to raise and lower the pressure of a closed system within 
the operating range of the controller without wasting gas under constant 
pressure conditions.
Plumbing
Connect your PCD into your process via the 1/8” NPT port on the front of the 
unit. This is the “Process” port. 
Connect a supply pressure greater than the full scale pressure control range of 
the device, not to exceed 145 PSIG, to the inlet 1/8” NPT port on the left side 
device. This is the “Inlet” port. 
The 1/8” NPT “Exhaust” port, located on the right side of the device can vent to 
atmosphere if the application is suitable, or to a collection network if necessary. 
The pressure at the exhaust port should be at atmospheric pressure or below to 
allow the controller to be used over its full scale range. 
If desired, there are two 8-32 mounting holes located on the bottom of the unit 
as shown in the dimensional drawing on page 40. 
Connect your PCD to power and output lines as detailed on pages 9 - 12.

Supply Pressure

Closed Volume

Decrease Pressure

Exhaust

Increase Pressure

Typical PCD Plumbing Diagram
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RS-232 / RS-485 OUTPUT AND INPUT
Configuring HyperTerminal®:

1.	 Open your HyperTerminal® RS-232 / RS-485 terminal program (installed under 
the “Accessories” menu on all Microsoft Windows® operating systems).

2.	 Select “Properties” from the file menu.
3.	 Click on the “Configure” button under the “Connect To” tab. Be sure the 

program is set for: 19,200 baud (or matches the baud rate selected in the 
RS-232 / RS-485 communications menu on the meter) and an 8-N-1-None 
(8 Data Bits, No Parity, 1 Stop Bit, and no Flow Control) protocol.

4.	 Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI 
or Auto Detect.

5.	 Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line 
Feeds” box is not checked and the “Echo Typed Characters Locally” box 
and the “Append Line Feeds to Incoming Lines” boxes are checked. Those 
settings not mentioned here are normally okay in the default position.

6.	 Save the settings, close HyperTerminal® and reopen it.

In Polling Mode, the screen should be blank except the blinking cursor. In order 
to get the data streaming to the screen, hit the “Enter” key several times to 
clear any extraneous information. Type “*@=@” followed by “Enter” (or using 
the RS-232 / RS-485 communication select menu, select @ as identifier and exit 
the screen). If data still does not appear, check all the connections and com port 
assignments.

Tareing via RS-232 / RS-485 (Gauges only):

Tareing (or zeroing) the pressure gauge provides it with a reference point for 
zero pressure. This is a very simple but important step in obtaining accurate 
measurements. It is good practice to “zero” the pressure gauge each time it is 
powered up. If the pressure reading varies significantly from zero after an initial 
tare, give the unit a minute or so to warm up and re-zero it. 

Zeroing the unit while there is any pressure will directly affect the accuracy 
by providing a false zero point. If in doubt about whether the pressure is zero, 
remove it from the line and open both ports to atmosphere before entering the 
Tare command. 

If the unit reads a significant negative value when removed from the line 
and open, it is a good indication that it was given a false zero. To send a Tare 
command via RS-232 / RS-485, enter the following strings:

In Streaming Mode:		  $$P<Enter>

In Polling Mode:		  Address$$P<Enter>        (e.g. B$$P<Enter>)
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Sending a Set-point via RS-232 / RS-485 (PC and PCR Series only): 

To send a set-point via RS-232 / RS-485, “Serial” must be selected under the 
“Input” list in the control set up mode. To give controllers a set-point, or change 
an existing point, simply type in a number between 0 and 65535 (2% over 
range), where 64000 denotes full-scale pressure, and hit “Enter”. 

The set-point column and pressure rates should change accordingly. If they do 
not, try hitting “Enter” a couple of times and repeating your command. The 
formula for performing a linear interpolation is as follows:

Value = (Desired Set-point X 64000) / Full Scale Pressure Range

For example, if your device is a 50 PSIG full-scale unit and you wish to apply a 
set-point of 12.5 PSIG you would enter the following value:

 	 16000 = (12.5 PSIG X 64000) / Full Scale Pressure Range

If the controller is in polling mode as described in Changing from Streaming 
Mode to Polling Mode, the set-point must be preceded by the address of the 
controller. For example, if your controller has been given an address of D, the 
set-point above would be sent by typing:

 	 D16000 followed by “Enter”

To adjust the Proportional and Differential (P&D) terms via RS-232 / RS-485 
(PC and PCR Series only):

Type *@=A followed by “Enter” to stop the streaming mode of information.

To adjust the “P” or proportional term of the PID controller, type *R21   
followed by “Enter”.

The computer will respond by reading the current value for register 21 between 
0-65535. It is good practice to write this value down so you can return to the 
factory settings if necessary. Enter the value you wish to try by writing the new 
value to register 21. For example, if you wished to try a “P” term of 220, you 
would type *W21=220 followed by “Enter” where the bold number denotes the 
new value.

The computer will respond to the new value by confirming that 21=220. To 
see the effect of the change you may now poll the unit by typing A followed 
by “Enter”. This does an instantaneous poll and returns the values once. You 
may type A “Enter” as many times as you like. Alternately, you could resume 
streaming mode by typing *@=@ followed by “Enter”. Repeat step 3 to remove 
the unit from the streaming mode.

To adjust the “D” or proportional term of the PID controller, type *R22 followed 
by “Enter”.

The computer will respond by reading the current value for register 22 between 
0-65535. It is good practice to write this value down so you can return to the 
factory settings if necessary. Enter the value you wish to try by writing the new 
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value to register 22. For example, if you wished to try a “D” term of 25, you 
would type *W22=25 followed by “Enter” where the bold number denotes the 
new value. 

The computer will respond to the new value by confirming that 22=25. To 
see the effect of the change you may now poll the unit by typing A followed 
by “Enter”. This does an instantaneous poll and returns the values once. You 
may type A “Enter” as many times as you like. Alternately you could resume 
streaming mode by typing *@=@ followed by “Enter”. Repeat. 

You may test your settings for a step change by changing the set-point. To do 
this type A32000 (A is the default single unit address, if you have multiple 
addressed units on your RS-232 / RS-485 line the letter preceding the value 
would change accordingly.) followed by “Enter” to give the unit a ½ full scale 
set-point. Monitor the unit’s response to the step change to ensure it is 
satisfactory for your needs. Recall that the “P” term controls how quickly the 
unit goes from one set-point to the next, and the “D” term controls how quickly 
the signal begins to “decelerate” as it approaches the new set-point (controls 
the overshoot).
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Changing From Streaming to Polling Mode: 

When the meter is in the Streaming Mode (RS-485 units do not have a 
streaming mode), the screen is updated approximately 10-60 times per second 
(depending on the amount of data on each line) so that the user sees the data 
essentially in real time. It is sometimes desirable, and necessary when using 
more than one unit on a single RS-232 line, to be able to poll the unit.

In Polling Mode the unit measures the flow normally, but only sends a line of 
data when it is “polled”. Each unit can be given its own unique identifier or 
address. Unless otherwise specified each unit is shipped with a default address 
of capital A. Other valid addresses are B thru Z.

Once you have established communication with the unit and have a stream of 
information filling your screen:

1.	 Type *@=A followed by “Enter” (or using the RS-232 / RS-485 
communication select menu, select A as identifier and exit the screen) to 
stop the streaming mode of information. Note that the flow of information 
will not stop while you are typing and you will not be able to read what you 
have typed. Also, the unit does not accept a backspace or delete in the line 
so it must be typed correctly. If in doubt, simply hit enter and start again. If 
the unit does not get exactly what it is expecting, it will ignore it. If the line 
has been typed correctly, the data will stop.

2.	 You may now poll the unit by typing A followed by “Enter”. This does an 
instantaneous poll of unit A and returns the values once. You may type A 
“Enter” as many times as you like. Alternately you could resume streaming 
mode by typing *@=@ followed by “Enter”. Repeat step 1 to remove the 
unit from the streaming mode.

3.	 To assign the unit a new address, type *@=New Address, e.g. *@=B. Care 
should be taken not to assign an address to a unit if more than one unit 
is on the RS-232 / RS-485 line as all of the addresses will be reassigned. 
Instead, each should be individually attached to the RS-232 / RS-485 line, 
given an address, and taken off. After each unit has been given a unique 
address, they can all be put back on the same line and polled individually.
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Collecting Data:

The RS-232 / RS-485 output updates to the screen many times per second. 
Very short-term events can be captured simply by disconnecting (there are 
two telephone symbol icons at the top of the HyperTerminal® screen for 
disconnecting and connecting) immediately after the event in question. The 
scroll bar can be driven up to the event and all of the data associated with 
the event can be selected, copied, and pasted into Microsoft® Excel® or other 
spreadsheet program as described below.

For longer term data, it is useful to capture the data in a text file. With the 
desired data streaming to the screen, select “Capture Text” from the Transfer 
Menu. Type in the path and file name you wish to use. Push the start button. 
When the data collection period is complete, simply select “Capture Text” from 
the Transfer Menu and select “Stop” from the sub-menu that appears.

Data that is selected and copied, either directly from HyperTerminal® or from 
a text file can be pasted directly into Excel®. When the data is pasted it will all 
be in the selected column. Select “Text to Columns...” under the Data menu in 
Excel® and a Text to Columns Wizard (dialog box) will appear. Make sure that 
“Fixed Width” is selected under Original Data Type in the first dialog box and 
click “Next”. In the second dialog box, set the column widths as desired, but 
the default is usually acceptable. Click on “Next” again.  In the third dialog box, 
make sure the column data format is set to “General”, and click “Finish”. This 
separates the data into columns for manipulation and removes symbols such 
as the plus signs from the numbers. Once the data is in this format, it can be 
graphed or manipulated as desired.

For extended term data capture see: “Sending a Simple Script to 
HyperTerminal®” on page 40.
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Data Format:

The data stream on the screen represents the pressure parameters of the main 
mode in the units shown on the display. For P Series Pressure Gauges, there is 
a single column of data. This column represents the measured pressure in the 
units specified at time of order and shown on the display.

+4.123
+4.123
+4.123
+4.123
+4.124
+4.125

P Series Pressure Gauge Data Format

For PC Series Controllers, there are 2 columns of data representing pressure and 
set-point. The first column is pressure (normally in PSIG), the second column is 
the set-point (in the units specified at time of order and shown on the display).

+014.70  014.70
+014.70  014.70
+014.70  014.70
+014.70  014.70
+014.70  014.70
+014.70  014.70

PC Series Vacuum and Pressure Controller Data Format
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Sending a Simple Script File to HyperTerminal®

It is sometimes desirable to capture data for an extended period of time. 
Standard streaming mode information is useful for short term events, however, 
when capturing data for an extended period of time, the amount of data 
and thus the file size can become too large very quickly. Without any special 
programming skills, you can use HyperTerminal® and a text editing program 
such as Microsoft® Word® to capture text at defined intervals.

1. Open your text editing program, MS Word for example.

2. Set the cap lock on so that you are typing in capital letters.

3. Beginning at the top of the page, type A<Enter> repeatedly. If you’re using 
MS Word, you can tell how many lines you have by the line count at the bottom 
of the screen. The number of lines will correspond to the total number of times 
the flow device will be polled, and thus the total number of lines of data it will 
produce.
For example:	 A

	 A
	 A
	 A
	 A
	 A
will get a total of six lines of data from the flow meter, but you can 
enter as many as you like.

The time between each line will be set in HyperTerminal.
4. When you have as many lines as you wish, go to the File menu and select 
save. In the save dialog box, enter a path and file name as desired and in the 
“Save as Type” box, select the plain text (.txt) option. It is important that it be 
saved as a generic text file for HyperTerminal to work with it.

5. Click Save.

6. A file conversion box will appear. In the “End Lines With” drop down box, 
select CR Only. Everything else can be left as default.

7. Click O.K.

8. You have now created a “script” file to send to HyperTerminal. Close the file 
and exit the text editing program.

9. Open HyperTerminal and establish communication with your flow device as 
outlined in the manual.

10. Set the flow device to Polling Mode as described in the manual. Each time 
you type A<Enter>, the meter should return one line of data to the screen.

11. Go to the File menu in HyperTerminal and select “Properties”.

12. Select the “Settings” tab.
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13. Click on the “ASCII Setup” button.

14. The “Line Delay” box is defaulted to 0 milliseconds. This is where you will 
tell the program how often to read a line from the script file you’ve created. 
1000 milliseconds is one second, so if you want a line of data every 30 seconds, 
you would enter 30000 into the box. If you want a line every 5 minutes, you 
would enter 300000 into the box.

15. When you have entered the value you want, click on OK and OK in the 
Properties dialog box.

16. Go the Transfer menu and select “Send Text File…” (NOT Send File…).

17. Browse and select the text “script” file you created.

18. Click Open.

19. The program will begin “executing” your script file, reading one line at 
a time with the line delay you specified and the flow device will respond by 
sending one line of data for each poll it receives, when it receives it.
You can also capture the data to another file as described in the manual 
under “Collecting Data”. You will be simultaneously sending it a script file and 
capturing the output to a separate file for analysis.
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TROUBLESHOOTING
Display does not come on or is weak.
Check power and ground connections and supply voltage. Please reference the 
technical specifications (pages 44-45) to assure you have the proper power for 
your model.

Pressure reading is approximately fixed either near zero or near full scale 
regardless of actual line pressure.
Differential pressure sensor may be damaged. A common cause of this problem 
is instantaneous application of high‑pressure gas as from a snap acting solenoid 
valve upstream of the meter. If you suspect that your pressure sensor is 
damaged please discontinue use of the controller and contact Alicat.

Displayed pressure is flashing and message POV is displayed:
Our pressure gauges and controllers display an error message (POV = pressure 
overrange) when a the pressure exceeds the range of the sensors in the device. 
When any item flashes on the display, the pressure measurement is not accurate. 
Reducing the pressure to within specified limits will return the unit to normal 
operation and accuracy. If the unit does not return to normal contact Alicat.

My controller does not respond to the set-point.
Check that your set-point signal is present and supplied to the correct pin and 
that the correct set-point source is selected under the SETPT SOURCE list in the 
control set up display (page 23). Also check that the unit is properly grounded. 

After installation, there is no pressure.
Alicat Scientific PC Series Controllers incorporate normally closed valves and 
require a set-point to operate. Check that your set-point signal is present and 
supplied to the correct pin and that the correct input is selected under the 
SETPT SOURCE list in the control set up display (page 24). Also check that the 
unit is properly grounded.

The pressure lags below the set-point.
Be sure there is enough pressure available. If either the set-point signal line and/
or the output signal line is relatively long, it may be necessary to provide heavier 
wires (especially ground wiring) to negate voltage drops due to line wire length. 
An inappropriate PID tuning can also cause this symptom if the D term is too large 
relative to the P term. See pages 27 and 28 for more information on PID tuning.

Controller is slow to react to a set-point change or imparts an oscillation to the flow.
An inappropriate PID tuning can cause these symptoms. Use at conditions 
considerably different than those at which the device was originally set up 
can necessitate a re-tuning of the PID loop. See pages 27 and 28 for more 
information on PID tuning. Note: The larger the volume pressured, the longer it 
takes to change the pressure in that volume.
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The output signal is lower than the reading at the display.
This can occur if the output signal is measured some distance from the gauge/
controller as voltage drops in the wires increase with distance. Using heavier 
gauge wires, especially in the ground wire, can reduce this effect.

My controller oscillates wildly and/or exhibits very different reactions to the set-
point than I expect.
Conditions considerably different than those at which the device was originally 
set up can necessitate a re-tuning of the PID loop. See pages 27 and 28  for 
more information on PID tuning.

RS-232 / RS-485 Serial Communications is not responding.
Check that your gauge is powered and connected properly. Be sure that the 
port on the computer to which the gauge is connected is active. Confirm that 
the port settings are correct per the RS-232 / RS‑485 instructions in this manual 
(Check the RS-232 / RS-485 communications select screen for current gauge 
readings). Close HyperTerminal® and reopen it. Reboot your PC. 
See pages 11, 12 and 33 for more information on RS-232 / RS-485 signals and 
communications.

Slower response than specified.
P Series Gauges and PC Series Controllers feature an RS-232 / RS-485 
programmable Geometric Running Average (GRA). Depending on the full scale 
range of the gauge, it may have the GRA set to enhance the stability/readability 
of the display, which would result in slower perceived response time. Please see 
“Pressure Averaging” on page 19.

Jumps to zero at low pressure.
P Series Gauges and PC Series Controllers feature an RS-232 / RS-485 
programmable zero deadband. The factory setting is usually 0.5% of full scale. 
This can be adjusted between NONE and 3.2% of full scale. See page 19.
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MAINTENANCE AND RECALIBRATION
General: P, PC, PCR and PCD Series Pressure Gauges and Controllers require 
minimal maintenance. They have no moving parts. The single most important thing 
that affects the life and accuracy of these devices is the quality of the gas being 
measured. The instruments are designed to measure CLEAN, DRY, NON-CORROSIVE 
gases. If your application requires an aggressive or corrosive gas, please consider 
Alicat’s  PS, PCS, PCRS and PCDS Series instruments (see page 53).
Recalibration: The recommended period for recalibration is once every year. A 
label located on the back of the controller lists the most recent calibration date. 
The controller should be returned to the factory for recalibration within one 
year from the listed date. Before calling to schedule a recalibration, please note 
the serial number on the back of the meter. The Serial Number, Model Number, 
and Date of Manufacture are also available on the Model Info display (page 20).
Cleaning: P, PC, PCR and PCD Series Pressure Gauges and Controllers  require no 
periodic cleaning. If necessary, the outside of the controller can be cleaned with 
a soft dry cloth. Avoid excess moisture or solvents.
For repair, recalibration or recycling of this product, contact:

Alicat Scientific, Inc.
7641 N Business Park Drive

Tucson, Arizona 85743
USA

Ph. 520-290-6060
Fax 520-290-0109

email: info@alicat.com
Web site: www.alicat.com

Pressure Conversion Table
PSI 1.00 = 51.7150 mmHg
PSI 1.00 = 2.0360 inHg
PSI 1.00 = 27.7080 inH20
PSI 1.00 = 68.9480 mbar
PSI 100.00 = 6.8046 atm
PSI 1.00 = 51.7150 torr
PSI 1.00 = 6.8948 kPa

mmHg 100.00 = 3.9370 inHg
mmHg 100 = 1.9337 PSI

inHg 100 = 49.1159 PSI
inH2O 100 = 3.6091 PSI
mbar 100 = 1.4504 PSI

atm 1 = 14.6959 PSI
torr 100 = 1.9337 PSI
kPa 100 = 14.5037 PSI

inHg 1 = 25.4000 mmHg
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Specification P Series PC & PCR Series Description
Full scale pressure < 2” H2O 

Accuracy Consult Factory Full Scale
Full scale pressure ≥ 2” H2O 

Standard Accuracy ± 0.25% Full Scale
Full scale pressure ≥ 2” H2O 

High Accuracy Option ± 0.125% Full Scale

Repeatability ± 0.08% Full Scale
Turndown Ratio 200:1

Adjustable Response Time1 5 100 Milliseconds
Operating Temperature −10 to +50 Degree Celsius

Zero Shift 0.02% Full Scale / °Celsius
Span Shift 0.02% Full Scale / °Celsius

Excess Pressure 128% Measurable 102.4% Controllable Full Scale
Burst Pressure 3X Full Scale

Supply Current Peak 0.035 0.250   (PCR: 0.750) Amp
Supply Voltage 7 – 30 12 – 30  

(PCR Series = 24 – 30) Volts dc

Input /Output Signal Standard RS-232 Serial & 0-5Vdc or PROFIBUS or 
DeviceNet™2

Electrical Connections 8 Pin Mini-DIN, DB9 or DB15

Wetted Materials3
302 & 303 Stainless Steel, Viton®. Silicone RTV, Silicon, Glass. All 
Controllers add:  400 Series Stainless Steel. PC Series Controllers 
only add: Brass

1. Volumes, feed pressures, exhaust pressures and line sizing will determine the limits of response times.
2. If selecting PROFIBUS or DeviceNet™ no analog signal is available.  PROFIBUS and DeviceNet™ 

units do not have the display.  See PROFIBUS or DeviceNet™ specifications for supply voltages 
and supply currents.

3. If your application demands a different material, please contact Info@alicat.com or 888-290-6060 for 
available options.

Technical Data for Pressure Gauges and Single Valve Pressure Controllers
The following specifications are for the standard configuration of the product. There are 
many options available.
PCR Series high flow pressure controllers are for applications with required flows above 
20LPM. Please contact Info@alicat.com or 888-290-6060 for additional PCR operating 
specifications.
Operating Specifications

Mechanical Specifications
Pressure Product Mechanical Dimensions Process Connections1

P Series Gauges 4.1”H x 2.4”W x 1.1”D 1/8” NPT Female
PC Series Controllers 4.1”H x 3.6”W x 1.1”D 1/8” NPT Female

PCR Series Controllers 5.5”H x 2.9”W x 5.5”D 3/4” NPT Female
1. Compatible with Swagelok® tube, Parker®, face seal, push connect & compression adapter 
fittings. Alternates available.

Select One Unit of Measure 
when Ordering

PSIA inHG Atm
PSIG inH2O Torr

mmHG mBar kPa

Standard Available Ranges
P Series Gauges PC, PCR Series Controllers
-15PSIG to 0PSIG -15PSIG to 0PSIG

2inH2OD 2inH2OG 2inH2OD 2inH2OG
4inH2OD 4inH2OG 4inH2OD 4inH2OG
1PSID 1PSIG 1PSID 1PSIG
5PSID 5PSIG 5PSID 5PSIG
15PSID 15PSIG 15PSIA 15PSID 15PSIG 15PSIA
30PSID 30PSIG 30PSIA 30PSID 30PSIG 30PSIA
100PSID 100PSIG 100PSIA 100PSID 100PSIG 100PSIA
150PSID 300PSIG 300PSIA 150PSID 300PSIG 300PSIA

500PSIG 500PSIA 500PSIG* 500PSIA*
*Not available on PCR
Other ranges available. Please contact Info@alicat.com or call 
888-290-6060.
Compatible with all non-corrosive gases. For use with water or other liquids please contact Info@alicat.com 
or 888-290-6060. For aggressive gases see our PS and PCS Series pressure gauges and controllers. 
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Technical Data for Dual Valve Pressure Controllers
The following specifications are for the standard configuration of the product. There are many options available.
PCRD Series high flow pressure controllers are for applications with required flows above 20LPM. 
Please contact Info@alicat.com or 888-290-6060 for additional PCRD operating specifications.

Operating Specifications
Specification PCD and PCRD Series Description

Full scale pressure < 2” H2O 
Accuracy Consult Factory Full Scale

Full scale pressure ≥ 2” H2O 
Standard  Accuracy ± 0.25% Full Scale

Full scale pressure ≥ 2” H2O 
High Accuracy Option ± 0.125% Full Scale

Feed Valve Orifice 0.050 Inches
Exhaust Valve Orifice 0.050 Inches

Alternate Valve Orifices 
Available 0.010 or 0.030 Inches

Repeatability ± 0.08% Full Scale
Turndown Ratio 200:1

Adjustable Response Time1 ≤100 Milliseconds
Operating Temperature −10 to +50 Degree Celsius

Zero Shift 0.02% Full Scale / °Celsius
Span Shift 0.02% Full Scale / °Celsius

Excess Pressure 102.4% Controllable Full Scale
Burst Pressure ≥3X Full Scale

Supply Current Peak 0.250  (PCRD: 0.750) Amp
Supply Current Average 0.050 Amp

Supply Voltage 12 – 30  (PCRD Series = 24 – 30) Volts dc

Input /Output Signal Standard RS-232 Serial & 0-5Vdc or PROFIBUS or 
DeviceNet™2

Electrical Connections 8 Pin Mini-DIN, DB9 or DB15

Wetted Materials3
302 & 303 Stainless Steel, Viton®, Silicone RTV, Brass, 400 Series 
Stainless Steel (standard units are for non-corrosive gases), 
Silicon, Glass.

1. Volumes, feed pressures, exhaust pressures and line sizing will determine the limits of response times.
2. If selecting PROFIBUS or DeviceNet™ no analog signal is available.  PROFIBUS and 

DeviceNet™ units do not have the display.  See PROFIBUS or DeviceNet™ specifications for 
supply voltages and supply currents.  Please contact Info@alicat.com or 888-290-6060 for PCD - 
PROFIBUS or DeviceNet™ options.

3. If your application demands a different material, please contact Info@alicat.com or 888-290-6060 
for available options.

Dual Valve Controllers Mechanical
Dimensions 

Process
Connections1 

PCD All Standard Ranges 4.1”H x 4.8”W x 1.1”D 1/8” NPT Female
PCRD All Standard Ranges 5.5”H x 10.6”W x 2.3”D 3/4” NPT Female

1. Compatible with Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings.
Standard Available Ranges

Select One Unit of Measure when 
Ordering

PSIA inHG Atm
PSIG inH2O Torr

mmHG mBar kPa

Mechanical Specifications

PCD and PCRD Series Pressure Controllers
-15PSIG to 0PSIG

2inH2OD 2inH2OG
4inH2OD 4inH2OG
1PSID 1PSIG
5PSID 5PSIG
15PSID 15PSIG 15PSIA
30PSID 30PSIG 30PSIA
100PSID 100PSIG 100PSIA
150PSID 300PSIG 300PSIA

500PSIG* 500PSIA*
*Not available on PCRD  Other ranges available. 
Please contact Info@alicat.com or call 888-290-6060.

Compatible with all non-corrosive gases. 
For use with water or other liquids please contact 

Info@alicat.com or 888-290-6060.
For aggressive gases see our PCDS and 

PCRDS Series pressure controllers. 
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





 









  

 











 







  








  














P Series:
All standard ranges

P Series:
Differential Pressure
All standard ranges
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


















 











 





































PC Series:
All standard ranges

PC Series:
Differential Pressure
All standard ranges
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






















 






 









 















 


 







 

PC3 Series:
All standard ranges

PCR3 Series:
All standard ranges
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























 



















 































PCR Series:
Most standard ranges

PCR Series:
Differential Pressure 5inH2O
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
























 

 





















  







 












 








PCD Series:
All standard ranges

PCD Series:
Differential Pressure
All standard ranges
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PCRD Series:
All standard ranges



 







 




























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Technical Data for Alicat PS Series Pressure and Vacuum Gauges
Alicat PS instruments are built for use with aggressive gases. For the most part these 
instruments maintain the specifications of equivalently ranged P Series devices. 
In addition to all non-corrosive gases, PS Gauges are configured to operate with 
the following aggressive gases. 
PS Gauge Aggressive Gas Compatibility List :

NO 		  Nitric Oxide to 100%
NF3 		  Nitrogen Triflouride to 100%
NH3 		  Ammonia to 100%
NO2 		  Nitrogen Dioxide to 100%
Cl2 		  Chlorine  to 100%
H2S 		  Hydrogen Sulfide to 100%
SO2 		  Sulfur Dioxide to 100%
Propylene to 100%

In addition the following gases are available upon request:
Refrigerant gases to 100% (refrigerant gases my require custom seals, 
consult Alicat)

If your application requires another gas or gas mixture, please contact Alicat. We will 
do our best to accommodate your request.

Technical Data for PCS, PCRS, PCDS and PCRDS Pressure and Vacuum Controllers
Alicat PCS, PCRS, PCDS and PCRDS instruments are built for use with aggressive gases. 
For the most part these instruments maintain the specifications of equivalently 
ranged PC, PCR , PCD and PCRD Series devices. 
In addition to all non-corrosive gases, PCS, PCRS, PCDS and PCRDS controllers are 
configured to operate with the following aggressive gases.
 PCS, PCRS, PCDS and PCRDS Controller Aggressive Gas Compatibility List :

NO 		  Nitric Oxide to 100%
NF3 		  Nitrogen Triflouride to 100%
NH3 		  Ammonia to 100%
NO2 		  Nitrogen Dioxide to 100%
H2S 		  Hydrogen Sulfide to 100% (22°C and under)
Propylene to 100%

In addition, the following gases are available upon request:
Refrigerant gases to 100% (refrigerant gases my require custom seals, 
consult Alicat)
Other gases to 1000 ppm in an inert carrier

If your application requires another gas or gas mixture, please contact Alicat. We will 
do our best to accommodate your request.

USING PS, PCS, and PCRS INSTRUMENTS with FLUIDS
PS, PCS and PCRS devices may be used with chemically compatible liquids. Please 
contact Alicat for technical assistance if your application involves fluids.
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Specification PS Series PCS & PCRS Series Description
Standard Accuracy ± 0.25% Full Scale

High Accuracy Option ± 0.125% Full Scale
Repeatability ± 0.08% Full Scale

Turndown Ratio 200:1
Adjustable Response 

Time1 5 100 Milliseconds

Operating Temperature −10 to +50 Degree Celsius
Zero Shift 0.02% Full Scale / °Celsius

Span Shift 0.02% Full Scale / °Celsius
Excess Pressure 128% Measurable 102.4% Controllable Full Scale

Burst Pressure 3X Full Scale
Supply Current Peak 0.035 0.250   (PCRS: 0.750) Amp

Supply Voltage 7 – 30 12 – 30  
(PCRS Series = 24 – 30) Volts dc

Input /Output Signal 
Standard

RS-232 or RS-485 Serial & 0-5Vdc  
or PROFIBUS or DeviceNet™2

Electrical Connections 8 Pin Mini-DIN, DB9 or DB15

Wetted Materials3 316LSS, FFKM (Kalrez) standard; Viton, EPDM, Buna, Neoprene as needed 
for some gases.  PCS, PCRS Series Controllers add: 303SS, 430FRSS

1. Volumes, feed pressures, exhaust pressures and line sizing will determine the limits of response times.
2. If selecting PROFIBUS or DeviceNet™ no analog signal is available.  PROFIBUS and DeviceNet™ 

units do not have the display.  See PROFIBUS or DeviceNet™ specifications for supply voltages 
and supply currents.

3. If your application demands a different material, please contact Alicat for available options.

Technical Data for PS Pressure Gauges and 
PCS and PCRS Single Valve Pressure Controllers

The following specifications are for the standard configuration of the product. There are many options 
available. PCRS Series high flow pressure controllers are for applications with required flows above 
20LPM. Please contact Info@alicat.com or 888-290-6060 for additional PCRD operating specifications.

Operating Specifications

Mechanical Specifications
Pressure Product Mechanical Dimensions Process Connections1

PS Gauges ≤ 100PSIG 3.8”H x 2.4”W x 1.1”D 1/8” NPT Female
PS Gauges > 100PSIG 4.1”H x 2.4”W x 1.1”D 1/8” NPT Female

PCS Controllers ≤ 100PSIG 3.8”H x 3.6”W x 1.1”D 1/8” NPT Female
PCS Controllers > 100PSIG 4.1”H x 3.6”W x 1.1”D 1/8” NPT Female

PCRS Controllers 5.5”H x 2.9”W x 5.5”D 3/4” NPT Female
1. Compatible with Swagelok® tube, Parker®, face seal, push connect & compression adapter fittings. 
Alternates available.

Select One Unit of 
Measure when Ordering
PSIA inHG Atm
PSIG inH2O Torr

mmHG mBar kPa

Standard Available Ranges
PS Series Gauges PCS, PCRS Series Controllers
-15PSIG to 0PSIG -15PSIG to 0PSIG

2inH2OD 2inH2OG 2inH2OD 2inH2OG
4inH2OD 4inH2OG 4inH2OD 4inH2OG
1PSID 1PSIG 1PSID 1PSIG
5PSID 5PSIG 5PSID 5PSIG
15PSID 15PSIG 15PSIA 15PSID 15PSIG 15PSIA
30PSID 30PSIG 30PSIA 30PSID 30PSIG 30PSIA
100PSID 100PSIG 100PSIA 100PSID 100PSIG 100PSIA
150PSID 300PSIG 300PSIA 150PSID 300PSIG 300PSIA

500PSIG 500PSIA 500PSIG* 500PSIA*
*Not available on PCRS
Other ranges available. Please contact Info@alicat.com or call 
888-290-6060.
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Technical Data for PCDS and PCRDS Dual Valve Pressure Controllers
The following specifications are for the standard configuration of the product. There are many options 
available. PCRDS Series high flow pressure controllers are for applications with required flows above 
20LPM. Please contact Info@alicat.com or 888-290-6060 for additional PCRDS operating specifications..

Specification PCDS and PCRDS Series Description
Standard  Accuracy ± 0.25% Full Scale

High Accuracy Option ± 0.125% Full Scale
Feed Valve Orifice 0.050 Inches

Exhaust Valve Orifice 0.050 Inches
Alternate Valve Orifices 

Available 0.010 or 0.030 Inches

Repeatability ± 0.08% Full Scale
Turndown Ratio 200:1

Adjustable Response Time1 ≤100 Milliseconds
Operating Temperature −10 to +50 Degree Celsius

Zero Shift 0.02% Full Scale / °Celsius
Span Shift 0.02% Full Scale / °Celsius

Excess Pressure 102.4% Controllable Full Scale
Burst Pressure ≥3X Full Scale

Supply Current Peak 0.250 Amp
Supply Current Average 0.050 Amp

Supply Voltage 12 – 30 Volts dc

Input /Output Signal Standard RS-232 or RS-485 Serial & 0-5Vdc  
or PROFIBUS or DeviceNet™2

Electrical Connections 8 Pin Mini-DIN, DB9 or DB15

Wetted Materials3 316LSS, 303SS, 430FRSS, FFKM (Kalrez) standard; Viton, EPDM, 
Buna, Neoprene as needed for some gases.

1. Volumes, feed pressures, exhaust pressures and line sizing will determine the limits of response times.
2. If selecting PROFIBUS or DeviceNet™ no analog signal is available.  PROFIBUS and DeviceNet™ units 

do not have the display.  See PROFIBUS or DeviceNet™ specifications for supply voltages and supply 
currents.  Please contact Applications Assistance for PCD - PROFIBUS or DeviceNet™ options.

3. If your application demands a different material, please contact Alicat for available options.

Dual Valve Controllers Mechanical
Dimensions 

Process
Connections1 

PCDS All Standard Ranges 4.1”H x 4.8”W x 1.1”D 1/8” NPT Female
PCRDS All Standard Ranges 5.7”H x 10.6”W x 2.3”D 3/4” NPT Female

1. Compatible with Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings.

Standard Available Ranges
Select One Unit of Measure when 

Ordering
PSIA inHG Atm
PSIG inH2O Torr

mmHG mBar kPa

Mechanical Specifications

Operating Specifications

PCDS and PCRDS Series Pressure Controllers
-15PSIG to 0PSIG

2inH2OD 2inH2OG
4inH2OD 4inH2OG
1PSID 1PSIG
5PSID 5PSIG
15PSID 15PSIG 15PSIA
30PSID 30PSIG 30PSIA
100PSID 100PSIG 100PSIA
150PSID 300PSIG 300PSIA

500PSIG* 500PSIA*
*Not available on PCRDS
Other ranges available. Please contact 
Info@alicat.com or call 888-290-6060.
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






  






















 
 

PCS Series:
All standard ranges 
to 500PSIG





















  






  



PS Series:
All standard ranges 
to 500PSIG
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


 

 

 







 




























  



















PCRS Series:
Most standard ranges

PCDS Series:
Most standard ranges
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



 






























 






PCRDS Series:
Most standard ranges
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Specification Meter  or 
Gauge

Small Valve
Controller

Large Valve
Controller Description

Input /Output Signal Digital PROFIBUS DP

Electrical Connections DB9
Supply Voltage: 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc

Supply Current 80mA @ 12Vdc
65mA @ 24Vdc

295mA @ 12Vdc
280mA @ 24Vdc 780mA @ 24Vdc

Technical Data for PROFIBUS Meters, Gauges and Controllers

NOTICE: The following specifications are applicable to Alicat PROFIBUS enabled meters, 
gauges and controllers only. 
All other operating specifications are shown in the Technical Data page for standard Alicat 
instruments.
All standard device features and functions are available and operate in accordance with the 
standard Alicat Scientific device operating manual provided with the device.

Power and Signal Connections:
Connect to the device using two DB9 
connectors.
The female top connection is PROFIBUS. 
The male connection on the side is power and 
RS‑232 or RS-485.
Pin out diagrams for all PROFIBUS enabled 
Alicat devices are shown:

PROFIBUS MC1SLPM shown to provide PROFIBUS connector dimensions only. Flow 
body and valve dimensions will vary with range. Please see Alicat’s device specifications for 
complete dimensions. 

PROFIBUS units do not have a display screen.

2 x 8-32 UNC ┬v  .350

.525

.35

4.264.08

3.76

3.59

1/8 NPT
Both Sides

1.05

.525

.35

2.225
.150 .125

.925

MC-1SLPM-PROFIBUS

1. NC
2. OPT GND
3. DP
4. RTS
5. DGD
6. VP
7. OPT 7 to 30VDC
8. DN
9. NC

5 1
9 6

TOP

1. NC
2. RS232RX
3. RS232TX
4. NC
5. GND
6. NC
7. 7 to 30VDC
8. GND
9. NC

1
6

5
9

SIDE
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Information for Alicat DeviceNet™ Compatible Instruments
DeviceNet™ OVERVIEW
Alicat DeviceNet™ compatible instruments support the Predefined Master/
Slave Connection Set.
There are two connectors on the Alicat meter/controller. The DeviceNet™ 
standard M12 Micro Connector found on the top of the unit is required for 
DeviceNet™ operations. 
The other connector is a DB9 (on the side of the unit) provided for convenience 
and is not necessary for operation of the DeviceNet™ compatible Alicat meter/
controller. The DB9 connector can be used for RS-232 communication (see DB9 
pin-out as shown Below).
DeviceNet™ CONNECTION
Utilizing the standard DeviceNet™ M12 micro connector allows the Alicat 
meter/controller to be easily attached to a DeviceNet™ network.
The pin out as defined in Volume Three of the DeviceNet™ Standard applies 
and is repeated here.
PIN Description Wire Color
1 Drain Bare
2 V+ (24VDC) RED
3 V- (GND) BLACK
4 CAN-H WHITE
5 CAN-L BLUE

MAC ID
All devices on a DeviceNet™ must have unique MAC ID. Alicat units can either 
be programmed with a customer requested ID or they will be defaulted to 63. 
In either case when an Alicat unit is attached to a DeviceNet™ and powered up 
it will send out a duplicate MAC request. 
If there already is a device on the network with the same address, the Alicat 
device will decrement its address and try again until it finds an unoccupied 
address. Once it finds a unique address, it stores that address into its 
nonvolatile memory, enabling it to come back on at the same address.

1. NC
2. RS232RX
3. RS232TX
4. NC
5. GND
6. NC
7. 7 to 30VDC
8. GND
9. NC

1
6

5
9

Side
To utilize the DB9 pinout on your DeviceNet™ 
compatible instrument, follow the pin-out diagram 
shown here.
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BAUD RATE

The following baud rates are available:	 125K	 250K	 500K

The default baud rate is 125K Baud. You may specify the baud rate at the time 
of order. 

The baud rate can be changed by using a set attribute single DeviceNet™ service 
request to the DeviceNet™ Object Class 03 Instance 01 Attribute ID 02. 

A setting of 0 is 125K baud, 1 is 250K baud, and 2 is 500K baud. In order for a 
change of baud rate to take affect the unit will have to be power cycled.

SUPPORTED DEVICE TYPE: Mass Flow Controller Device Type 0x1A 

SUPPORTED CLASSES: Identity Object Class 0x01 
SUPPORTED ATTRIBUTES:

Attribute Services Description Default Value
1 Get Vendor ID 1174 (0x0496)
2 Get Device Type 0x1A (Mass Flow)
3 Get Product Code See Product Codes
4 Get Revision (Maj, Min) 0x01,0x01
5 Get Status 0x00
6 Get Serial Number 0x########
7 Get Product Name Alicat Scientific Inc MFC

DeviceNet™ Object Class 0x03	 DeviceNet™ Assembly Object Class 0x04
Connection Object Class 0x05	 S-Device Supervisor Class 0x30
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



Rev. No. Description Date

DeviceNet™ MC10SLPM shown to provide DeviceNet™ connector dimensions only. Flow 
body and valve dimensions will vary with range. Please see Alicat’s device specifications for 
complete dimensions.

DeviceNet™ units do not have a display screen.

Specification Meter  or 
Gauge

Small Valve
Controller

Large Valve
Controller Description

Input /Output Signal 
Digital DeviceNet™

Electrical Connections M12 Micro Connector
Supply Voltage: 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc

Supply Current 80mA @ 12Vdc
65mA @ 24Vdc

295mA @ 12Vdc
280mA @ 24Vdc 780mA @ 24Vdc

Technical Data for DeviceNet™ Meters, Gauges and Controllers
NOTICE: The following specifications are applicable to Alicat DeviceNet™ enabled meters, gauges 
and controllers only. 
All other operating specifications are shown in the Technical Data page for standard Alicat 
instruments.
All standard device features and functions are available and operate in accordance with the 
standard Alicat operating manual provided with the device. 
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Alicat Portable Meters and Gauges
Alicat Portable Flow Meters and Gauges use a common 9 Volt battery located in the top 
section of your meter.
Output signals from the flow meter are passed through the female connector on 
top of the flow meter. Turn the switch on top of the flow meter “off” when the 
meter is not in use.
Normal (9V alkaline) battery life is approximately 8 hours (30-40 hours with a 
9V-lithium battery), however many factors can affect this. 
Note: Alicat recommends the use of non-rechargeable 9V-lithium batteries in all 
MB TFT (color display portable) meters and gauges.
Replace the battery as often as required. A yellow LED indicates low voltage and 
that the battery should be replaced. 
A false signal can result when the voltage drops below its normally regulated level. 
Alicat Portable Flow Meters and Gauges can also be powered by an optional AC/
DC plug-in wall adaptor. With the adaptor plugged into the flow meter, the battery 
is bypassed and the meter will operate solely off the adaptor power supply.
Replacing the Battery:  
1.	 Remove the four Phillips head screws from the front cover and gently remove 

it as shown below.
2.	 Remove the 9V battery, pulling the top of the battery out first.
3.	 Disconnect the old battery from the harness and replace it with a new battery.
4.	 Install the new battery bottom end first and replace the back cover so that 

the cushioning pad presses directly down on the battery.
5.	 Replace the four Phillips head screws.
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Rev. No. Description Date

AC/DC Adaptor Port

Battery cover removal



64

Option: Remote Electronics for High Line or Gas Temperatures

Some applications involve operating 
temperatures outside the standard Alicat 
device specifications. A solution using 
remote electronics is available. (This option is 
not applicable for liquid devices.)

The flow body’s components are minimized 
to only the required sensors. The flow data is 
sent to the microprocessor electronics up to 
6 feet away from the sensor package. 

Relocating the sensitive electronics allows 
for installation of the flow body in ambient 
temperatures as high as 85° Celsius with gas temperatures under 100°Celsius. 

In these applications we recommend our custom gauge calibration at a 
gas temperature of up to 70°Celsius. This will reduce zero shift errors that 
occur when actual gas flow temperatures deviate substantially from the gas 
calibration temperature. 

This configuration is also used in integrations that require a compact flow 
package at the installation point.

Option: Remote Panel Display 

Our Remote Display option offers the flexibility of using 
Alicat’s display with units that are embedded inside 
processes or instrument enclosures. 

The Remote Display retains all of the same features as our 
standard display.

The Remote Display is ideal for:

●  OEMs Remote Panel Mounting	 ●  Embedded Systems

●  Gas Panels			   ● Fuel Cell Test Stations

●  Leak Detection Systems		 ●  Artificial Environments
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Accessory: BB9 Multi-Drop Box

The BB9 Multi-Drop Box makes it convenient to wire 
multiple flow and/or pressure devices to a single RS‑232 or 
RS-485 port. Now available with a USB interface!

The Multi-Drop Box has nine 8 pin Mini-DIN ports available. 
The ports are to be used with a standard double ended 8 pin 
Mini-DIN (DC-62) style cable going from the box to each flow 
or pressure device. 

A single DB9 D-SUB type connector (COM PORT) connects, using the included 
cable, to the serial connector on a PC or laptop. 

All of the flow and/or pressure devices are powered via a terminal block on the 
front of the box. 

If more than nine devices will be required, additional Multi-Drop Boxes can be 
daisy chained together with a double ended 8 pin Mini-DIN cable plugged into 
any receptacle on both boxes.

BB9 Power Supply for Large Valve Controllers: The PS24VHC (Power Supply 
24Vdc High Current) is a 6.5Amp 24Vdc power supply designed for running 
multiple large controllers on a BB9. 

The 6.5Amp power supply can run as many as 8 large valve controllers, which 
makes it ideal for the BB9 and multiple large valve (or small valve / large valve 
combination) controllers on a BB9.

BB-9 Multi-Drop 
BoxØ .156 Thru 4 Places

1.75

Ø .340 Thru 2 PL

3.46

6.75 1.55

5.06

BB9 Multi-Drop Box

Ø .156 Thru 4 Places

1.75

Ø .340 Thru 2 PL

Ø .175 Thru 2 PL

3.46

6.75 1.55

5.06

6.75

7.56
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Accessory: Flow Vision™ SC Software
Flow Vision™ SC is an intuitive software interface to help your test 
cycles run smoother and shorten your engineering time! 

Flow Vision™ SC lets you connect to and communicate with multiple Alicat 
units simultaneously. Now you can view virtual displays, control tabs, charts 
and data lines from every connected Alicat device on the same screen.

Flow Vision™ SC supports all RS-232 and RS-485 Serial communication 
functions, including: gas selection, tareing, set‑point control, valve tuning 
and flow averaging.
Session Saving: Save and reload your configuration data with confidence. 
Script Building: Create scripts to adjust a controller’s set-point value at 
variable specified time intervals.
Charting: Chart as many parameters as you want off as many devices as you 
want, with color coding, zooming, and printing functionality.
Alarms: Create software alarms that will notify you of given parameter conditions.
Data Capture & Logging: Capture and log data to either a .csv file or a .txt file. 
Improved Data Logging and Data Log File Splitting for easy to manage data.

Accessory: Flow Vision™ MX Software
Alicat’s New Flow Vision™ MX software gives you an easy way to do  
GAS BLENDING using Alicat Mass Flow Controllers and your own PC. 

Flow Vision™ MX software is a simple way to connect up to six Alicat 
mass flow controllers and create your own gas mix concentrations.

Using our inexpensive BB9-USB and a single USB connection you can: 

•	 Create your own gas blends 
•	 Adjust flow rates 
•	 Save your specific blend formulas.

All the controllers can be powered through the BB9-USB with a single 
power supply.

Just connect your unique gases to each controller, select the gas type either 
locally on the controller or through Flow Vision™ MX, manifold the flow 
outputs and create your gas mix.
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Accessories
Part Number Description

FLOWVISIONSC Flow Vision™ SC software for interface with all Alicat instruments

FLOWVISIONMX Flow Vision™ MX software for gas blending

BB9 9 position Multi-Drop Box

BB9-I 9 position Multi-Drop Box, Industrial connectors

PVPS24U Universal 100-240 VAC to 24 Volt DC Power Supply Adapter

PS24VHC High current power supply for BB9 use with Large Valve Controllers

PCASE Industrial carry and storage case for portable meters/gauges

DC-61 8 Pin Male Mini-DIN connector cable, single ended, 6 foot length

DC-251 8 Pin Male Mini-DIN connector cable, single ended, 25 foot length

DC-301 8 Pin Male Mini-DIN connector cable, single ended, 30 foot length

DC-501 8 Pin Male Mini-DIN connector cable, single ended, 50 foot length

DC-751 8 Pin Male Mini-DIN connector cable, single ended, 75 foot length

DC-6RT 8 Pin Male Right Angle Mini-DIN Cable, single ended, 6 foot length
DC-62 8 Pin Male Mini-DIN connector cable, double ended, 6 foot length
DC-252 8 Pin Male Mini-DIN connector cable, double ended, 25 foot length
DC-502 8 Pin Male Mini-DIN connector cable, double ended, 50 foot length

DC-602 8 Pin Male Mini-DIN connector cable, double ended, 60 foot length

MD8DB9 8 Pin Male Mini-DIN to DB9 Female Adapter, 6 foot length

DBC-251 DB15 cable, single ended, 25 foot length

510199 DB9 cable, double-ended female, 3 meter length

IC10 Industrial cable, 6 Pin, single ended, 10 foot length

IC10-18G 18 gauge industrial cable, 6 Pin, single ended, 10 foot length

IC20 Industrial cable, 6 Pin, single ended, 20 foot length

IC24-18G 18 gauge industrial cable, 6 Pin, single ended, 24 foot length

IC50 Industrial cable, 6 Pin, single ended, 50 foot length

IC-102 Industrial cable, 6 pin double ended, 10 foot length

USB-RS232 RS-232 to USB Converter

REMOTE Remote Electronics with Display

RD Remote Panel Mount Display
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MNPT to Compression Fittings
10-32 - 1/8” SS-200-1-0157
10-32 - 1/4” SS-400-1-0256
1/8” - 1/8” SS-200-1-2
1/8” - 1/4” SS-400-1-2
1/8” - 3/8” SS-600-1-2
1/8” - 1/2” SS-810-1-2
1/8” - 3mm SS-3M0-1-2
1/8” - 4mm SS-4M0-1-2
1/8” - 6mm SS-6M0-1-2
1/8” - 8mm SS-8M0-1-2

1/8” - 12mm SS-12M0-1-2
1/4” - 1/8” SS-200-1-4
1/4” - 1/4” SS-400-1-4
1/4” - 3/8” SS-600-1-4
1/4” - 1/2” SS-810-1-4
1/4” - 3mm SS-3M0-1-4
1/4” - 4mm SS-4M0-1-4
1/4” - 6mm SS-6M0-1-4
1/4” - 8mm SS-8M0-1-4

1/4” - 12mm SS-12M0-1-4
1/2” - 1/8” SS-200-1-8
1/2” - 1/4” SS-400-1-8
1/2” - 3/8” SS-600-1-8
1/2” - 1/2” SS-810-1-8
1/2” - 3/4” SS-1210-1-8
1/2” - 6mm SS-6M0-1-8
1/2” - 8mm SS-8M0-1-8

1/2” - 12mm SS-12M0-1-8
1/2” - 16mm SS-16M0-1-8
3/4” - 1/4” SS-400-1-12
3/4” - 1/2” SS-810-1-12
3/4” - 3/4” SS-1210-1-12

3/4” - 12mm SS-12M0-1-12
3/4” - 16mm SS-16M0-1-12

Filters & Elements FNPT-MNPT
10-32 5μ 510053

10-32 20μ 510054
1/8” 20μ ILF-1/8-20
1/4” 40μ ILF-1/4-40
1/2” 40μ ILF-1/2-40*
3/4” 40μ ILF-3/4-40*

20μ element ILFE20
40μ element ILFE40
40μ element ILFE40L*

Filters & Elements FNPT-FNPT*
10-32 5μ CF-303-20-316

*requires MNPT to MNPT coupler to 
interface with Alicat flow bodies

10-32 Male UNF to 1/8 FNPT Adapter

410133

Male M5 (10-32) Buna-N O-ring face seal 
to 1/8”Female NPT

Accessories
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Eight Pin Mini-DIN Connector Pin-Outs
If your Alicat Instrument was ordered with the standard Eight Pin Mini-DIN 

connection, please be sure to reference the following pin-out diagram.

A locking industrial connector is standard on all CSA/ATEX approved devices. It is also 
available as an option on all other Alicat instruments.

1
6

5

4
3

2

Pin Function Cable Color
1 Power In  ( + ) Red
2 RS-232TX / RS-485 + Blue
3 RS-232RX / RS-485 - White
4 Remote Tare Meters (Ground to Tare)

Analog Set-Point Input (Controllers)
Green

5 Ground (common for power,
     communications and signals)

Black

6 Signal Out (Voltage or Current as ordered) Brown

Note: The above pin-out is applicable to all the flow meters and controllers ordered with the 
six pin industrial connector. The availability of different output signals depends on the options 
ordered. DO NOT use the above pin-out for PC-EXTSEN-ISC controllers! See pages 78-80 
for PC-EXTSEN-ISC pin-out information.

Locking Industrial Connector Pin-Outs
If your Alicat Instrument was ordered with a Six Pin Locking Industrial 
connection, please be sure to reference the following pin-out diagram.

Standard 8 Pin Mini-DIN Pin-Out

Pin Function Mini-DIN 
cable color

1 Inactive or 4-20mA Primary Output Signal Black

2 Static 5.12 Vdc or Secondary Analog Output (4-20mA, 5Vdc, 10Vdc) 
                         or Basic Alarm Brown

3 RS-232 Input Signal Red
4 Analog Input Signal Orange
5 RS-232 Output Signal Yellow
6 0-5 Vdc (or 0-10 Vdc) Output Signal Green
7 Power In (as described above) Blue
8 Ground (common for power, communications and signals) Purple

Note: The above pin-out is applicable to all the flow meters and controllers with the 
Mini‑DIN connector. The availability of different output signals depends on the options 
ordered. Underlined Items in the above table are optional configurations that are 
noted on the unit’s calibration sheet.DO NOT use the above pin-out for PC-EXTSEN 
controllers! See pages 78-80 for PC-EXTSEN pin-out information. 



 







1 2

3 4 5

6 7 8
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DB9 Pin-Outs
If your Alicat instrument was ordered with a DB9 connection, 
please reference the following pin-out diagram.

Pin Function
1 Inactive or optional 4-20mA Primary Output Signal

2 Static 5.12 Vdc or Secondary Analog Output (4-20mA, 5Vdc, 10Vdc) 
                         or Basic Alarm

3 Serial RS-232RX or RS-485 -

4 Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground 
for remote tare function on non-controllers)

5 Serial RS-232TX or RS-485 +
6 0-5 Vdc (or 0-10 Vdc) Output Signal
7 Power In (+Vdc)
8 Ground (common for power, communications and signals)
9 Ground

Note: The above pin-out is applicable to all flow meters and controllers 
with the DB9 connector. The availability of different output signals depends 
on the options ordered. Underlined Items in the above table are optional 
configurations that are noted on the unit’s calibration sheet.

Do not connect RS-485 to RS-232 units. Check part 
number or contact factory to verify RS-485 functionality.

Due to variance in cable manufacturing, please identify 
proper wiring/pins via continuity check & color when using 
bare cut multi-strand cables.



 









1 2 3 4 5

6 7 8 9

Standard DB9 Pin-Out Female Connector
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PROFIBUS Pin-Outs
If your Alicat Instrument was ordered with a PROFIBUS connection, 

please be sure to reference the following pin-out diagram.

1. NC
2. OPT GND
3. DP
4. RTS
5. DGD
6. VP
7. OPT 7 to 30VDC
8. DN
9. NC

5 1
9 6

TOP

1. NC
2. RS232RX
3. RS232TX
4. NC
5. GND
6. NC
7. 7 to 30VDC
8. GND
9. NC

1
6

5
9

SIDE

Power and Signal Connections:
Connect to the device using two DB9 connectors.
The female top connection is PROFIBUS. 
The male connection on the side is power and RS-232 or RS-485.
Pin out diagrams for all PROFIBUS enabled Alicat devices are shown below.
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DB15 – Pin-Out Alicat Style

Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 Ground
4 N/C
5 Power Supply (+Vdc)
6 N/C
7 N/C

8  Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc
12 N/C
13 RS-232 RX (receive) or RS-485 –
14 Ground
15 RS-232 TX (send) or RS-485 +

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 1, 3, 9, 10, and 14 are connected together inside of the device and are 
common grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).

The following pin-out chart describes the safest and generally compatible arrangement 
when connecting a non-Alicat DB15 wire to a DB15 equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.

Male Connector Front View Female Connector Front View

8

15 13 11 9

25
8

1513119

2 5
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Pin Number Function
1 Ground
2 Primary Analog Signal Output

3 Analog Tare (meters — when grounded)*
Analog Set-Point Input (controllers)*

4 Ground
5 Power Supply Common
6 Ground
7 Power Supply (+Vdc)
8 RS-232 Tx (send) / RS-485, A (-) [receive]
9 Ground
10 N/C
11 N/C
12 Secondary Analog Signal Output / fixed 5.12Vdc*
13 N/C
14 N/C
15 RS-232 Rx (receive) / RS-485, A (+) [send]

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
* Added to allow for full use of features on Alicat devices, may not be present on host wiring
NOTE: Pins 1, 4, 5, 6, and 9 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).

DB15A – Pin-Out “Aalborg” Style

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15A equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.

Male Connector Front View Female Connector Front View

8

15 12 9

25
8

15129

2 53
3

7
7
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DB15B – Pin-Out “Brooks” Style

Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 N/C
4 N/C
5 Power Supply (+Vdc)
6 N/C
7 N/C

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc
12 N/C
13 N/C
14 RS-232 RX (receive) or RS-485 –
15 RS-232 TX (send) or RS-485 +

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 1, 9, and 10 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15B equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.

9

5

Male Connector Front View Female Connector Front View

1415

8
8

1514119

2 5

11

2
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DB15K – Pin-Out “MKS” Style

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15K equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.

Pin Number Function
1 N/C
2 Primary Analog Signal Output
3 N/C
4 N/C
5 Power Supply Common
6 N/C
7 Power Supply (+Vdc)

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Secondary Analog Signal Output / fixed 5.12Vdc *
10 N/C
11 Ground
12 Ground
13 RS-232 RX (receive) or RS-485 – *
14 RS-232 TX (send) or RS-485 + *
15 Ground

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 5, 11, 12 and 15 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring.

Male Connector Front View Female Connector Front View

8

13 149

2 5
8

1314 9

25
7

7
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DB15H – Pin-Out “Hastings H” Style

Pin Number Function
1 N/C
2 RS-232 RX (receive) or RS-485 – *
3 N/C
4 N/C
5 Ground
6 Primary Analog Signal Output
7 Power Supply Common
8 N/C
9 N/C
10 Secondary Analog Signal Output / fixed 5.12Vdc *
11 Power Supply (+Vdc) 
12 Ground
13 N/C

14 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

15 RS-232 TX (send) or RS-485 + *
Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 5, 7 and 12 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring.

Male Connector Front View Female Connector Front View

11 151410

2 6

1115 14 10

26
7 7

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15H equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.



77

DB15S – Pin-Out “Sierra” Style

Pin Number Function
1 Ground
2 Primary Analog Signal Output 
3 N/C
4 N/C
5 Ground
6 N/C
7 N/C

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc *
12 RS-232 RX (receive) or RS-485 – *
13 Power Supply (+Vdc) 
14 RS-232 TX (send) or RS-485 + *
15 Ground

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 1, 5, 9, 10 and 15 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring.

Male Connector Front View Female Connector Front View

11 141312

2

9 1114 13 9

2
8

8

12

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15S equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.
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NOTES FOR USING PC-EXTSEN DEVICES
PC-EXTSEN units connect a Pressure Controller (with no internal pressure 
sensor) to an end-user supplied external pressure sensor. Designed mainly 
for the vacuum coating industry, the PC-EXTSEN marries the sensing ability 
of an existing capacitance manometer or ion gauge with a Alicat’s 16 Series 
electronics package and internal PID algorithm. This enables fast and precise 
control of extreme vacuum conditions in the coating chamber. 

The PC-EXTSEN receives a linear analog signal from the external sensor. This analog 
signal corresponds to a full scale range that is specified by the user at the time 
of order (and corresponds to the scale of the external sensor). The PC-EXTSEN 
interprets this analog signal as its sensed pressure. 

The PC-EXTSEN then utilizes its proportional control valve to control the flow 
of gas into the chamber, allowing for closed loop vacuum control based on the 
interpreted signal. Set-point control and PID tuning all happen through the 
instrument’s interface, via the buttons on the display, or a user selected analog 
interface (0-5V, 0-10V, or 4-20mA), or through a multidrop RS-232 interface. 

There are two base models of PC-EXTSEN controllers, the PC-EXTSEN-D, and the 
PC-EXTSEN-D-ISC. 

The PC-EXTSEN-D has an 8 pin Mini-DIN female electrical connector as its electrical 
connection to power, ground, signal input from the external sensor, RS-232 transmit 
and receive, as well as analog transmit and receive. The PC-EXTSEN-D also has a 
barrel plug electrical connection if you choose to power the device through a wall 
mounted AC adaptor, rather then wiring power to the 8 pin minidin connection. 

The PC-EXTSEN-D-ISC is identical to the PC-EXTSEN-D except it has an additional 
locking 6 pin industrial electrical connector which is intended for use as a dedicated 
connection to your external sensor, leaving the 8 pin Mini-DIN connection available 
to be used as a dedicated RS-232 or analog interface connection. 

Please refer to the appropriate sections of this operating manual for complete 
information regarding use and tuning of your PC-EXTSEN controller.

When using a PC-EXTSEN-D-ISC device, it is recommended that power 
and communications to the PC-EXTSEN-D-ISC device be wired through 
the 8 pin Mini-DIN connector and that the industrial connector is 
maintained as a dedicated connection to the external sensor.  

WHEN USING THE INDUSTRIAL CONNECTOR AS A DEDICATED 
CONNECTION TO THE SENSOR, DO NOT WIRE ANY SIGNAL INPUT INTO 
PIN 2 ON THE Mini-DIN CONNECTOR.
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PC-EXTSEN-D Pin-Outs
The following pin-out diagram is applicable to all standard PC-EXTSEN-D 
devices. If your device was ordered with custom pin-out requirements, please 
contact Alicat for assistance.

PC-EXTSEN-D Standard 8 Pin Mini-DIN Pin-Out

Pin Function Mini-DIN 
cable color

1 Inactive or 4-20mA Primary Output Signal Black
2 External Sensor Signal Input* Brown
3 RS-232 Input Signal Red
4 Analog Input Signal Orange
5 RS-232 Output Signal Yellow
6 0-5 Vdc (or 0-10 Vdc) Output Signal Green
7 Power In Blue
8 Ground (common for power, communications and signals) Purple

*If you are using the PC-EXTSEN-D-ISC’s 6 pin locking connection to receive the 
external sensor input signal do not wire any signal into pin 2 of the Mini-DIN.



 







Pin 7 which is normally utilized to provide power into the Alicat device can 
be used to provide power to your external sensor. Please make sure that 
the power you are providing to the device is compatible with the power 
your sensor can accept before choosing to wire power in this manner.

CAUTION! Do not connect power to pins 1 through 6 as permanent 
damage can occur!

POWER AND SIGNAL CONNECTIONS
Power can be supplied to your controller through either the power jack or the 8 pin 
Mini-DIN connector. 
An AC to DC adapter which converts line AC power to DC voltage and current as 
specified below is required to use the power jack. 
A 2.1mm, positive center, 12-30 Vdc AC/DC adapter rated for at least 250 mA is 
required to use the adapter jack in a PC Series controller. 
A 2.1mm, positive center, 24-30 Vdc AC/DC adapter rated for at least 500 mA is 
required to use the adapter jack in a PCR Series controller.
NOTE: 4-20mA analog output requires at least 15 Vdc.
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PC-EXTSEN-D-ISC Pin-Outs
The PC-EXTSEN-D-ISC is equipped with an additional Six Pin Locking connection, 
for use as a dedicated connection to your external sensor. 

This leaves the 8 pin Mini-DIN connection available to be used as a dedicated 
RS-232 or analog interface connection. 

Please be sure to reference the following pin-out diagram. The following pin-out 
diagram is applicable to all standard PC-EXTSEN-D-ISC devices. If your device was 
ordered with custom pin-out requirements, please contact Alicat for assistance.

1
6

5

4
3

2

Pin Function Cable Color
1 Power In  ( + ) Red
2 In-Active Blue
3 In-Active White
4 External Sensor Signal Input Green
5 Ground (common for power,

     communications and signals)
Black

6 In-Active Brown

PC-EXTSEN-D-ISC Standard 6 Pin Locking Connection Pin-Out

Pin 1 which is normally utilized to provide power into the Alicat device can 
be used to provide power to your external sensor. Please make sure that 
the power you are providing to the device is compatible with the power 
your sensor can accept before choosing to wire power in this manner.

When using a PC-EXTSEN-D-ISC device, it is recommended that power 
and communications to the PC-EXTSEN-D-ISC device be wired through 
the 8 pin connector and that the industrial connector is maintained as a 
dedicated connection to the external sensor.  

WHEN USING THE INDUSTRIAL CONNECTOR AS A DEDICATED 
CONNECTION TO THE SENSOR, DO NOT WIRE ANY SIGNAL INPUT INTO 
PIN 2 ON THE Mini-DIN CONNECTOR.

The 6 pin locking connection on the –ISC unit has only three active pins, 
power, ground and signal input from the external sensor.

PC-EXTSEN-D-ISC 

6 Pin Locking Connection

8 Pin Mini-DIN Connection End-user Supplied 
External Sensor
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Additional Information for Alicat CSA and ATEX Approved Devices
See the following page for Special Conditions regarding the use of these units!

1
6

5

4
3

2

Pin Function Cable Color
1 Power In  ( + ) Red
2 RS-232TX / RS-485 + Blue
3 RS-232RX / RS-485 – White
4 Analog Input Signal Green
5 Ground (common for power,

          communications and signals)
Black

6 Signal Out (Voltage or Current as ordered) Brown

EEx nA IIC T4 
Class I, Div. 2 Group A, B, C and D T4

24 Vdc, 0.800A max
Class I, Zone 2 AEx nA IIC T4

WARNINGS: 

EXPLOSION HAZARD – DO NOT DISCONNECT WHILE CIRCUIT IS LIVE 
UNLESS AREA IS KNOWN TO BE NON-HAZARDOUS.

EXPLOSION HAZARD – SUBSTITUTION OF COMPONENTS MAY IMPAIR 
SUITABILITY FOR CLASS I, DIVISION 2.

II 3 G

Pin# Wire color
1 Red
2 Blue
3 White
4 Green
5 Black
6 Brown

IC-10 Cable

Ø .710

.425

Industrial Connector Overall Clearance
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All Alicat CSA / ATEX approved devices are equipped with a locking 6 pin industrial connector.
The power and signal connections are shown below.

IC-10 Locking Industrial Cable Clearance Requirements for 
Industrial Connector



82

USE of Alicat instruments  (M, MS, MC, MCS, MCR, MCRS, P, PS, PC, PCS, PCR and 
PCRS product families only) in Class 1 Division 2 applications.

CSA certifies the use of this product for general use as well as use in hazardous 
locations as defined by Class 1 Division 2 Group A, B, C and D T4. 
 CSA certification is indicated by the product label as shown below and 
not by the statements in this, or any accompanying documentation.

Special Conditions:
To comply with CSA certification the following information is included in the product literature:

•	 When equipment is properly labeled, it is suitable in Class I, Division 2, Group A, B, 
C and D, T4

o	 Tamb. -40°C to +50°C 
•	 Electrical Rating 24Vdc, 0.800A max
•	 Instruments shall be powered by a CSA certified, UL listed, Class II external power 

supply suitable for the application
•	 Instruments shall be housed in an enclosure with a minimum IP54 rating or location 

providing equivalent protection
•	 Instrument’s final approval shall be provided by the local authority having jurisdiction

EEx nA IIC T4 
Class I, Div. 2 Group A, B, C and D T4

24 Vdc, 0.800A max
Class I, Zone 2 AEx nA IIC T4

X – See manual for special conditions
WARNINGS: 

EXPLOSION HAZARD – DO NOT 
DISCONNECT WHILE CIRCUIT IS LIVE 
UNLESS AREA IS KNOWN TO BE NON-
HAZARDOUS.
EXPLOSION HAZARD – SUBSTITUTION 
OF COMPONENTS MAY IMPAIR 
SUITABILITY FOR CLASS I, DIVISION 2.

www.AlicatScientific.com

Alicat Scientific, Inc.
Tucson, AZ USA
Tel: 520-290-6060

II 3 G

USE of Alicat instruments (M, MS, MC, MCS, MCR, MCRS, P, PS, PC, PCS, PCR and PCRS 
product families only) in applications requiring ATEX Certification.
Properly labeled Alicat instruments comply to the following ATEX standard:

II 3 G EEx nA IIC T4 (-40°C ≤ Ta ≤ +50°C)
The examination certificate was issued by the CSA in accordance with 
accepted practices and procedures. This confirms compliance with the 
European ATEX Directive or Group II Category 3G equipment.

ATEX certification is indicated by the product label as shown above and not by the 
statements in this, or any accompanying documentation.
Special Conditions:

•	 Properly labeled equipment is only certified for use in ambient temperatures in the 
range of -40°C to +50°C only

•	 Electrical Rating 24Vdc, 0.800A max
•	 Instruments shall be powered by a CSA certified, UL listed, Class II external power 

supply suitable for the application
•	 Instruments shall be housed in an enclosure with a minimum IP54 rating or location 

providing equivalent protection
•	 Instrument’s final approval shall be provided by the local authority having jurisdiction


